
12/3 

NEWSLETTER 

INTERNATIONAL NANNOPLANKTON ASSOCIATION 

VOLUME 12 NUMBER 3 1990 



THE INTERNATIONAL NANNOPLANKTON ASSOCIATION 

PRESIDENT 
Katharina von Salis Perch-Nielsen 
Geologisches Institut ETH-Z 
CH -8092 Zurich 
Switzerland 
Tel. 01-256-3695 

SECRETARY I TREASURER 
Magdy Girgis 
Robertsons Group 
Llandudno 
Gwynedd LL30 1SA, UK 
Tel. 0492-581811 

US TREASURER 
John C. Steinmetz 
Marathon Oil (Expl. & Prodn.) 
P.O. Box 269 
Little ton 
Colorado 80160, USA 

BIBLIOGRAPHER 
William G. Siesser 
Dept. of Geology 
Vanderbilt University 
Nashville 
Tennessee 37235, USA 

SILICOFLAGELLATE BIBLIOGRAPHER 
Stacia Spaulding 
760 Magazine St., #113 
New Orleans 
Louisiana 70130, USA 

NEWSLETTER EDITOR 
Jeremy R. Young 
Palaeontology Dept. 
The Natural History Museum 
London SW7 5BD, UK 
Tel.071-938-8996 Fax.071-938-9277 

DEPUTY EDITOR 
Paul R. Bown 
Micropalaeontology Unit 
University College London 
London WClE 6BT, UK 
Tel. 071-387-7050 Ext.2431 

ODP CORRESPONDENT 
John Firth 
Ocean Drilling Project 
Texas A&M University 
College Station 
Texas 77840, USA 

NOMENCLATURALSECRETARY 
Shirley E. van Heck 
clo NAM, XGSI3 
Schepersmaat 2 
9405 TA Assen 
The Netherlands 

INA MEMBERSHIP: Open to anyone interested, on receipt of subscription. Subscription is £12 
(students £6) per annum. Send to Secretary I Treasurer. Or $20 (Students $10), send to US 
Treasurer. Membership queries and changes of address send to Secretary I Treasurer. 

BIBUOGRAPHIES: Please send reprints of any coccolith, calcisphere or silicoflagellate articles 
to the relevant bibliographer. 

BACK ISSUES: All issues available, from Secretary I Treasurer. Price per issue: Non-members 
£121$20; Members £6/$10; Student members £31$5. For air mail delivery add £11$2 per issue. 
Full set of back issues £50 (inc. postage). 

COPYRIGHT: Any part of the Newsletter may be reproduced for scientific or educational 
purposes. Wherever appropriate the source and authors should be clearly noted. 

NEWSLETTER MATTERS: Send all contributions, suggestions etc. to the editor. Deadline for 
next issue 15th March 1990. For advice to contributors see inside back cover. 

INA NEWSLETTER: Published by the International Nannoplankton Association. Printed by Archer Press, London. 
ISSN-0255-013X 



INA NEWSLETTER 
Proceedings of the International Nannoplankton Association 

Volume 12 Number 3 November 1990 

EDITORIAL ITEMS AND ANNOUNCEMENTS . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46 
SPECIAL OFFER - PROCEEDINGS INA FLORENCE MEETING 46 

INA CONFERENCE - PRAGUE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47 
REGISTRATION FEE 48 
ABSTRACT SUBMISSION 49 

MEETING REPORT - HUXLEYI SYSTEM WORKSHOP, Blagnac Sept. 1990 . . . . . . . 50 

OCEAN DRILLING PROGRAM NEWS, John Firth . . . . . . . . . . . . . . . . . . . . . . . . . . 51 

BOOK REVIEWS - LIVING COCCOLITHOPHORES, Jeremy Young . . . . . . . . . . . . . 53 
HANDBOOK OF PROTOCTISTA 53 
THE CHROMOPHYTE ALGAE - PROBLEMS AND PERSPECTIVES 54 
ATLAS DU PHYTOPLANCTON MARIN- Volume 3 54 

BOOK REVIEW - HANDBOOK OF CALCAREOUS NANNOFOSSILS, VOL. 4, 
Osman Varol & Shirley E. van Heck . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56 

THE ICBN: THINGS YOU NEED TO KNOW - 3, Shirley E. van Heck . . . . . . . . . . . . 59 

A NEW TECHNIQUE FOR CONSTRUCTING CAMERA-READY RANGE 
CHARTS USING A MACINTOSH COMPUTER, Wuchang Wei . . . . . . . . . . . . 62 

NON-CORRELATION OF NANNOFLORAL COMPOSITION WITH ISOTOPIC 
VARIATION IN CENOMANIAN CHALK-MARL RHYTHMS, SOUTH-
EASTERN ENGLAND, Jackie Bumett ............................... 65 

A NEW NANNOFOSSIL ZONATION SCHEME FOR THE BOREAL CAMP ANIAN, 
Jackie Bumett. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67 

BIBLIOGRAPHY AND TAXA OF CALCAREOUS NANNOPLANKTON, W.G. Siesser 71 
NEWTAXA 79 

MEMBERSHIP CHANGES ............................................. 82 
NEW MEMBERS 82 
CHANGES OF ADDRESS 84 

INA Newsletter 12/3 - 1990 45 



EDITORIAL ITEMS AND ANNOUNCEMENTS 

This issue is a joint production with Jeremy Young doing the initial work and Paul Bown the 
final editing and organisation of printing and mailing. We hope this works and apologise in 
advance for any glitches. 

Silicoflagellate bibliography: Stacia has completed the new silicoflagellate bibliography and it is 
currently being proof-checked by Shirley van Heck. It is rather long and will be published in 
instalments starting next issue. 

Prague meeting: Organisation for this is progressing well despite the uncertainties in 
Czechoslovakia. The time scale is almost finalised, the excursion guide has been written, and 
castings worked out. It is somewhat more expensive than we had hoped, but still substantially 
cheaper than a conference in Western Europe. The second circular and application form are 
enclosed. Note that accommodation should be booked as soon as possible since there is a 
shortage of hotel space in Prague. 

Subscriptions: Subscriptions are due now, invoice enclosed. If it is equally convenient to you 
please pay in £UK rather than $US, it saves us time and transfer fees. Many overdue members 
responded to the reminders sent out in the last issue, this has definitely helped INA funds. 

Reviews: We are watching out for books of interest to nannoplankton workers to review. In 
addition it would be good to review any monographs or other separately published works 
dealing exclusively or largely with nannofossils or living nannoplankton. Please could authors of 
such works arrange with their publishers to send review copies to the editor. 

Paul Bown, Magdy Girgis, Jeremy Young 

**************************************************** 

SPECIAL OFFER - PROCEEDINGS INA FLORENCE MEETING 
Editors: Franca Proto-Decima, Domenico Rio, and Simonetta Monechi 

The proceedings of the 1989 Florence INA Meeting are being prepared for publication as a 
special issue of the Memorie di Scienze Geologiche - a high quality A4 format publication of 
the Department of Geology, University of Padua. It will include some 30 refereed papers on 
diverse aspects of coccolith biostratigraphy, taxonomy, and palaeoceanography from the Recent 
to the Jurassic. Publication is due in Spring 1991, price approx. $120, £60. 

We are able to offer exclusively through INA a prepublication order price of only £38. At 
about £1.20 per paper this is a very cost effective way of improving your library - and using this 
offer will help the editors (who need advance sales). Please send payment now (in any case 
before 1-3-1991) to Magdy Girgis, normal INA account. Copies will be sent by surface mail 
immediately after publication, £10 extra for air mail outside Europe. This offer is open to libraries 
and institutions as well as INA members. 

Prepublication order price: £38 surface mail, £48 air mail 
Send to: Magdy Girgis, Robertsons Group, Uandudno, Gwynedd LL30 1SA, UK 
Bank Account details: INA Account. I Ace no. 0205466 I Uoyds Bank I Branch Code 30-95-
13. 

**************************************************** 
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INA CONFERENCE - PRAGUE 
8-14 September 1991 -Second circular and call for abstracts 

TENTATIVE PROGRAMME 
6-8 Sept. Arrival in Prague 
8 Sept. Morning (& ?afternoon): Informal workshop 1 (Palaeontology Dept. Charles 

University). 
13.00 - 19.00: Excursion to Cretaceous of the Bohemian Basin 

9 Sept. 08.00 - 18.00: Registration, opening session and scientific sessions (Novotneho 
hivka). 
Evening: Welcome party. 

10 Sept. 08.00 - 18.00: Scientific sessions 
Evening: Concert. 

11 Sept. 08.00 - 12.00: Scientific sessions 
13.00 - 18.00: General discussions or Informal Workshop 2. 
Evening: Farewell Party. 

12 Sept. 08.00 - 12.00: Sightseeing in Prague, Informal Workshops 3 & 4 (Palaeontology 
Dept., Charles University). 
14.00: Departure for Excursion 2. 

13 Sept. Excursion 2 (West Carpathians, South Moravia). 
Evening: Dinner in wine vault. 

14 Sept. Excursion 2, returning to Prague at 18.00. 

SCIENTIFIC SESSIONS 
About 120 specialists have shown interest in taking part. Requests for topics of scientific 
sessions have been as follows: Living coccolithophores 27: Morphology and evolution of 
nannofossils 44; Paleoecology, palaeoceanography 63; Biostratigraphy 82; Reliability of 
biostratigraphic data 56. So, the authors are asked for their talks and posters on these five 
topics. 

INFORMAL MEETINGS, WORKSHOPS 
3 or 4 informal meetings or workshops will be held in the Dept. of Paleontology, Charles 
University before and after the main scientific sessions. Possible workshops topics are given on 
the application form and the most demanded will be chosen. Light microscopes and if necessary 
an SEM will be at the disposal of these meetings. 

EXCURSIONS 
Excursion 1: Bohemian Cretaceous Basin (Turonian, Coniacian). Sept 8th. Price 30DM (50DM 
after 1 June). 
Excursion 2: West Carpathians, South Moravia (Miocene, Paleogene, Cretaceous, Jurassic), 
Sept. 12 -14. Price 170DM (200DM after 1 June), includes coach, accommodation, and meals. 

VENUES 
Registration and lecture sessions: Klub techniku, Novotneho lavka 5, Prague. 
Informal workshops, excursion departure: Dept. of Paleontology, Charles University, Albertov 
6, Prague. 

WELCOME PAR1Y 
A welcome party is planned for Monday, Sept. 9th. Price 60DM 

OONCERT 
A concert of baroque music is planned for Tuesday, Sept. lOth, preliminary price 20DM 
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REGISTRATION FEE 
170 DM (German Marks) for INA Members 
220 DM Non-members and late registrants (after 1 June 1991). 
100 DM Students 
Or equivalent in US$ at current exchange rate. 
Payment of fees should be by money order (inc. Eurocheques) or bank transfer to: 
KOMERCNI BANKA HODONIN, NARODNI TRIDA 67, 69500 HODONIN, 
CZECHOSLOVAKIA 
Bank account numbers: DM payment 34278 - 228656 - 671 

US$ payment 34833 - 228656 - 671 

PLEASE PAY BEFORE 1st June 1991. 

SPECIAL NOTE- UK REGISTRANTS ONLY. Please pay registration fee direct toJeremy Young 
(this will cover abstract volume cost). £58, students £34. Cheques to J.R.Young - INA Account. 
Lloyds Bank (30-13-49), Ace. No. 0181929. 

POSTERS 
The size of individual posters is 1 x 1.5m 

ORAL PRESENTATIONS 
All talks must be presented in English. During the sessions slide-projectors (24x36 mm), 
overhead projectors and light microscopes will be available. Please let me know if you also need 
video tape recorder, computer etc. 

PROCEEDINGS 
Proceedings will be published as a special number of "Knihovnickas Zemni Plyn a Nafta" 

ACCOMMODATION 
For hotel accommodation contact the office of Cedok Travel Agency in your country or the 
Cedok Travel Agency in Prague as soon as possible. Price will depend on hotel category. There 
are Cedok Travel Agencies in: Amsterdam, Belgrade, Berlin, Brussels, Bucharest, Budapest, 
Copenhagen, Frankfurt, London, Moscow, New York, Paris, Rome, Sofia, Stockholm, Vienna, 
Warsaw, and Zurich. 
Cheaper accommodation has been reserved in the student hostel (provisional price 40DM per 
night). If you are interested please fill in carefully the application form. We will send you the 
details immediately. 

ENTRY INTO CZECHOSLOVAKIA 
A valid passport and a Czechoslovak visa are required for entry. For visas consult embassies and 
consulates of the Czechoslovak Federal Republic worldwide. Visas are NOT needed for 
nationals of the USA, Canada or most European countries (Austria, Belgium, Bulgaria, 
Denmark, Germany, Ireland, Italy, Finland, France, Hungary, The Netherlands, Norway, Poland, 
Portugal, Rumania, Spain, Sweden, USSR, UK, Yugoslavia). 

DEADLINES 
February 28th 1991 Deadline for receipt of application form. 
May 1 1991 Deadline for receipt of abstracts. 
June 1 1991 Deadline for receipt of fees. 
THE THIRD CIRCULAR WITH FULL DETAILS OF ORGANIZATION AND THE 
PROGRAM WILL BE SENT IN SPRING 1991. 
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ABS'IRACf SUBMISSION 

The abstract volume will be produced as a special issue of the INA Newsletter, and the normal 
conventions of the Newsletter should be followed, as outlined below. Abstracts may be submitted 
either as . proof ready copy or on computer disc. 

Proof ready copy: Submit on A4 paper (210x297mm) with 2.5cm left, right and top margins, 
3.5cm bottom margin. Single spacing, 15 point (elite) text. If possible use a laser printer. 

Submission on disc: Include print-out (2 copies), and details of system used. The following are 
preferable. IBM/MS-DOS, any format, 5.25" or 3.5", discs (ideal 5.25", 1.2 Mb). Text as 
WordPerfect, WordStar, Smart, DCA, Navy DIF, MultiMate, or ASCII files (ideal WordPerfect 
5.0). Macintosh, 3.5" discs, MS-Word, MacWrite or ASCII files. Amstrad, 3"discs, Locoscript, 
Wordstar, Tasword or ASCII files. 

Length: Up to 500 words, and up to 1 page of diagrams (NO plates). 

Title: Use following format 

CLARIFICATION OF RETICULOFENESTRA PERPLEXA (BURNS) WISE 1983 
Wuchang Wei, Dept of Geology, Florida State University, Tallahassee, USA 

Backman (in Heck, 1981) first pointed out that .... 

Diagrams: Submit as very clean computer printouts, photographs, or photocopies of final size, 
do not send large or delicate originals. Plates cannot be included. 

References: Use standard (World List) abbreviations, and format of examples below. ODP & 
DSDP volumes should be treated as periodicals using the following abbreviations: IRDSDP; 
Proc. ODP Init. Rep.; Proc ODP Sci. Res. 

SpencerS. & Dobb A 1988: New observations on Upper Cretaceous vombatidae. J. Worn. Res., 2S, 35-67. 
McCarthy JJ. 1980: Nitrogen. In, Morris I. (ed.) "The Physiological Ecology of Phvtoplankton", Blackwell, p.191-234. 

Send Abstracts To: Bohumil Hamrsmid, add Mikropaleontologie, MND Hodonin Uprokova 6, 
Hodonin 695 30, Czechoslovakia. Deadline 1st May 1991. Late abstracts will not be included. 
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MEETING REPORT - HUXLEYI SYSTEM WORKSHOP, Blagnac Sept. 1990 
Convenors; Peter Westbroek, Jan van Hinte, Patrick Holligan 

As we are all well aware coccolithophores have roles in the greater scheme of things beyond 
shedding dinky little plates onto the sea-bottom to record the age of rocks. Within the oceanic 
ecosystem they are one of the main primary producers, and so foodstocks for zooplankton and 
ultimately fish. They have a major impact on "global biogeochemical cycles" and on world 
climate through their activities as photosynthesisers, carbonate producers and dimethyl sulphide 
emitters. In the geological column they provide records of temperature change from organic 
biomarkers and oxygen isotopes, and productivity records from carbon isotopes and bulk 
carbonate sedimentation rates, with further signals from assemblage composition and 
intraspecific variation. 

So coccolithophores are of interest to scientists from a very wide range of disciplines and 
are as liable to appear in discussions of global warming as of stratigraphy. The purpose of this 
meeting was to investigate whether a special study could be devised which would usefully focus 
these interdisciplinary interests. Specifically an integrated study of aspects of the physiology, 
population dynamics, taxonomy, and input to oceanographic fluxes of Emiliania huxleyi was 
discussed. E.huxleyi has much to commend itself as a model system - it is enormously abundant 
and so probably one of the most ecologically important single species on earth. It is readily 
cultured in the laboratory and much is already known about its biology and biochemistry. It is 
detectable from space since blooms of E.huxley~ apparently uniquely, are characterised by 
production of vast numbers of loose reflective liths. 

The workshop was organised for two main research groups, with various other guest 
participants. The Dutch group consisted of about a dozen workers from the Leiden 
Biogeochemistry Unit, Amsterdam Geology Dept. and NIOZ (The Netherlands Ocean Research 
Institute). This group has a funded project, with cruises, post-does etc. The British group is less 
organised, being currently an informal grouping of about nine scientists from The Plymouth 
Marine Laboratory and half-a-dozen others. In all some thirty scientists attended from a 
bewildering range of disciplines. Nannoplankton specialists included Judith van Bleiswijk, John 
Green, Derek Harbour, Michael Knappertsbusch, Hans Thierstein, Paul van der Wal and Peter 
Westbroek. 

The venue was a French Chateau on the Dordogne River - conveniently owned by our hosts 
Jan and Dorien van Hinte. The wonderful setting contributed to a very pleasant atmosphere, 
and we were exceptionally well fed and watered. We had a day and a half of talks followed by 
another day and a half of workshop sessions - largely held on the chateau lawns. 

Was the meeting productive? Certainly it was a success in itself, we all enjoyed meeting 
workers from quite different disciplines, and benefitted from discussing a wide range of subjects. 
The concept of synthesising our disparate research topics into a common project was exciting. 
The degree and nature of future progress .still depends on the vagaries of research proposals, 
and of individuals personal priorities and opportunities, but we did conclude that there was a 
real opportunity to exploit "the huxleyi system as a window on global geo-biosphere interactions". 

Jeremy Young, The Natural History Museum, London 
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OCEAN DRILLING PROGRAM NEWS 
John Firth, ODP, Texas A&M University 

ODP Leg 129 drilled the Pigafetta and East Mariana Basins of the western Pacific, in search 
of Jurassic sediments and basement. It succeeded at ODP Site 801, where Middle Jurassic 
(Callovian) sediments were found. Age assignments were based solely on radiolarians. 
Nannofossils were virtually absent in the Jurassic sequence, but present in overlying middle 
Cretaceous sediments. Nannofossil palaeontologists aboard the JOIDES Resolution were 
Elisabetta Erba (U. of Milan, Italy) and Mitch Covington (FSU, Tallahassee, FL). 

ODP Leg 130 drilled the Ontong-Java submarine plateau in the western equatorial Pacific in 
order to investigate the Cretaceous-Recent paleoceanography and palaeobathymetry of the 
plateau along depth transects. 5 sites were drilled, recovering a record 4.8 km of core. Sites 803 
and 807 recovered complete K-T boundary sections, one in a silt/claystone sequence, the other 
in a carbonate sequence. Nannofossil workers for Leg 130 were Jan Backman (V. of Stockholm, 
Sweden) and Toshiaki Takayama (Kanazawa Univ., Japan). 

ODP Leg 131 drilled the toe of the Nankai Trough accretionary prism to study the 
hydrogeology, physical properties and structural styles of the deformed sediments. A complete 
section through the frontal thrust fault, decollement, and basement was achieved at Site 808. 
Extremely detailed structural, physical properties, and geochemical data were compiled, along 
with new in-situ measurements of temperature, stress, and pore pressure. The sequence was of 
middle Miocene to Recent age, with no unconformities. Nannofossil workers on Leg 131 were 
Gunnar 0/afsson (U. of Stockholm, Sweden) and John Firth (ODP, College Station, TX). 

ODP Leg 132 was an engineering leg geared to testing new drilling technology such as a 
Diamond Coring System (DCS) in hard chert and limestone strata. It also drilled a Pleistocene 
to Campanian carbonate sequence on the Shatsky Rise. 

ODP Leg 133 (Aug.- Oct. 1990) drilled the Northeast Australia Margin to study high resolution 
Neogene paleoceanography and sea-level history, and the development of the Great Barrier 
Reef. Drilling revealed that the Great Barrier Reef may be only 500,000 years old, and that 
there appear to have been multiple sea-level drops resulting in "deaths" of reefs on this margin 
through the Neogene. The nannofossil workers for Leg 133 were Stefan Gartner (Texas A&M, 
College Station, TX) and Wuchang Wei (FSU, Tallahassee, FL). 

ODP Leg 134 (Oct. - Dec. 1990) will drill the Vanuatu arc-ridge collision zone. Nannofossil 
workers will be Thomas Staerker (FSU, Tallahassee, FL). 

ODP Leg 135 (Jan. -Feb. 1991) will drill the Lau Basin, an actively spreading backarc basin. 
Nannofossil workers will be Paula Quintemo (U.S.G.S., Menlo Park, CA) and Michael Styzen 
(Shell Offshore, New Orleans, LA). 

ODP Leg 136 (March 1991) will drill the Hawaiian Arch, south of Honolulu. A hole will be 
cored to provide a test site for emplacement of an Ocean Seismic Network station. The 
nannofossil worker on board will be John Firth (Ocean Drilling Program). 

ODP Leg 137 (April 1991) will re-enter Hole 504B, the deepest hole drilled into oceanic 
basement, in order to clear the hole of debris and prepare for future drilling and downhole tool 
experiments. No palaeontologists will sail on this cruise. 

ODP Leg 138 (May - June 1991) will drill in the eastern equatorial Pacific Ocean, to study 
Neogene high resolution paleoceanography. The nannofossil palaeontologists will be Jose-Abel 
Flares (University of Salamanca, Spain) and Isabella Raffi (Universita di Parma, Italy). 
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ODP Leg 139 (July- Sept. 1991) will drill in the sediment covered spreading centres of the Juan 
De Fuca Ridge and the Gorda Ridge in the northeastern Pacific, to study submarine 
hydrothermal systems and hydrothermal deposits. The nannofossil palaeontologist will be Shaozi 
.Mao (FSU, Tallahassee, FL). 

ODP Leg 140 (Sept.-Nov. 1991) will drill either in Hole 504B (ocean crust) or on the East 
Pacific Rise (again ocean crust). No palaeontologists will sail on this cruise. 
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BOOK REVIEWS - LIVING COCCOLITHOPHORF.S 

Nannoplankton workers of whatever type have a need for information on the biology of living 
coccolithophores, their taxonomy and their relationship to other groups. There is, as yet, no 
single book which conveniently summarises all the relevant information but three new works 
approach aspects of this subject and deserve attention. 

HANDBOOK OF PROTOCfiSTA 
Editors L. Margulis, J.O. Corliss, M Melkonian and D.J. Chapman 

Jones and Bartlett Publishers, Boston. 1990. pp. xli + 914. ICBN 0-86720-052-9. ea. £190. 
Hardcovers 

This is a massive book which aims to provide high class reviews of the biology of all the groups 
in the kingdom Protoctista; i.e. all unicellular eucaryotes - and some multicellular algae. It 
comprises 35 chapters each dealing with a single phylum, several of which are sub-divided with 
essays on different classes. The classification is essentially that of Margulis and Schwartz (1988). 
The chapters are written by different authors but uniformity is provided by a standard plan to 
each chapter of INTRODUCfiON (General characteristics, occurrence, literature, history of 
knowledge, practical importance); HABITATS AND ECOLOGY; CHARACTERIZATION 
AND RECOGNITION (usually the main section including cytology, lifecycles and classification); 
MAINTENANCE AND CULTIVATION; EVOLUTIONARY HISTORY; BIBLIOGRAPHY. 

The introductory chapters provide an interesting discussion of modern ideas on protoctist 
relationships and biology. At the end of the book there is an etymological appendix, an extensive 
glossary (80 pages, c.2000 terms), and three indices (organism, author, general). 

The chapter on prymnesiophytes (pp.293-317) is co-authored by John Green, Peter 
Westbroek, and Katharina Perch-Nielsen and is reasonably representative of the strengths and 
weaknesses of the systematic chapters in general. The authors are all distinguished specialists 
and so the chapter is free from the mistakes and misrepresentations of many general texts. It 
is not, however, entirely up to date since it was written several years ago - the handbook has 
been in preparation since 1980! The main coverage is of cell biology, with good discussions of 
flagella structure, scales, coccolithogenesis, life cycles and mitosis. Taxonomy, biogeography, and 
evolution by contrast are only briefly outlined. Diversity is illustrated by a page of line drawings 
of cell types, another of scale types and one plate of, very fine, SEMs. The bibliography is a 
restrained list of about 140 significant references. Thus the chapter is neither an exhaustive 
compilation of knowledge nor an identification guide, but rather a useful summary of the 
biological characteristics of the group - as indeed was intended. 

The other chapters cover a very wide range of groups, micropalaeontologists and marine 
biologists might divide these into four categories. First there are the groups we are used to, 
although often with less familiar names; chlorophytes, ciliates, diatoms, dinoflagellates, forams, 
radiolaria, silicoflagellates, and of course coccolithophores. Second there are less familiar groups 
which are still directly relevant such as bisoecids, choanoflagellates, and eustigmatophytes. For 
some of these groups these are virtually the only reviews available. Third there are benthic algae 
and fresh water groups which are useful for comparative purposes. Fourth there are parasitic 
and mould organisms of only peripheral interest to us. The book is of course not organised 
along these lines, nor does it follow any existing classification. Instead the phyla are organised 
in four groups based on the presence I absence of complex life cycles and undulipodia ( = cilia 
and eucaryote flagella). This has the desired effect of emphasising the probable artificiality of 
classifications but results in a more or less chaotic distribution of the groups we might recognise. 

The idiosyncratic organisation, unfamiliar names, and the fact that the contents page is 
buried 31 pages from the beginning make the handbook rather daunting. Nonetheless it will be 
an invaluable reference for any workers who need information on the biology of these groups. 
The price is obviously too high for normal individuals but research groups and laboratories 
would be well advised to buy copies, as well as ensuring that it is present in their institution 
libraries. 
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TilE CHROMOPHYfE ALGAE - PROBLEMS AND PERSPECTIVES 
Eds. J.C. Green, B.S.C. Leadbeater, and WL. Diver 

Systematics Assoc. Spec. Vol. 38, Oxford University Press. pp. xii + 425. ICBN 0-19-857713-3. £60 
Hardcovers 

Subtitles such as "Problems and Perspectives" usually indicate a heterogeneous assemblage of 
papers published together for no more reason than that they came out of a single conference. 
This volume is an interesting exception, the papers do come from a conference (held in 
Plymouth in April 1988) but it evidently had an unusually sharp focus. Recent work, in particular 
by Cavalier-Smith has suggested that the brown and golden-brown algae (including 
coccolithophores) form a natural group which should be accorded Kingdom status (see fig.1). 
In order to test and develop this concept the conference assembled specialists working on a wide 
range of groups and investigating very varied aspects of their biology. The result is a 
heterogeneous mix of papers but with a strong inter-connections. 

There are 21 papers of three types. 9 papers deal with particular aspects of chromophyte 
biology of possible phylogenetic significance - including chloroplast structure, biochemistry and 
molecular genetics, flagellar structure, and mitosis. Another 9 papers deal with individual groups, 
particularly those of uncertain affinity with the core-chromophytes. There is no individual 
chapter on the Prymnesiophytes but they are well dealt with in the non-systematic chapters. 
Finally there are 3 overview papers. The sequence of papers is logical, they are rather well 
cross-referenced and the editing is immaculate. 

Three characters emerge clearly as typifying the chromophytes: possession of flagellae with 
stiff tubular hairs (retronemes); chloroplasts with chlorophyll a and c (vs chlorophyll a and bin 
chlorophytes I green algae); and the embedding of the chloroplasts in a four-layered membrane 
derived from the endoplasmic reticulum. Core-chromophytes have all these characters and 
idclude the diatoms, chrysophytes (including the silicoflagellates), raphidophytes, 
eustigmatophytes and xanthophytes. The probable relationship of other groups to these is shown 
in Fig.2. The prymnesiophytes appear as a virtually unique group since they have typical 
chromophyte chloroplasts (and similar scale formation to chrysophytes) but have quite different 
flagellar structure - smooth flagcllae and a haptonema. Dinophytes differ markedly from core 
chromophytes and appear to be only distantly related. 

Looking over the groups included it is striking that they dominate the modern phytoplankton, 
but that none of them has a pre-Mesozoic geological record. Moreover, many of the tentative 
phylogenies in this volume show prymnesiophytes as diverging very early in the evolution of the 
chromophytes. This raises the real possibility that the entire Kingdom Chromista may be a post
Palaeozoic development and that the first appearance of coccolithophores in the Triassic may 
record a rather more profound event than merely the development of planktonic calcification. 
It would be fascinating to see the result of cladistic analysis which should be possible using the 
data in this volume, and in the Handbook of Protoctista. 

ATLAS DU PHYTOPLANCfON MARIN - Volume 3 
Series editor: A. Soumia. Editor: M-J. Chretiennot-Dinet 

Editions du CNRS, Paris, 1990. pp.261. ISBN 2-252-04325-5. Softcover. 250FF 

The Atlas du Phytoplancton Marin is a French language generic level guide to marine 
phytoplankton. Volume 1 (Sournia 1986) covered dinoflagellates with short sections on 
cyanophytes and raphidophytes. Volume 2 (Ricard 1987) dealt with the diatoms. This final 
volume covers nine miscellaneous groups and the prymenesiophytes, which account for about 
half the book. A uniform format has been adopted throughout the series. Each group has one 
chapter with an introductory section on biology, classification and methodology, followed by 
systematic descriptions. These are based on genera and include data on type species, etymology, 
and references plus discussions of generic characteristics and specific differentiation. The 
organisation is taxonomic rather than alphabetic with notes on all the higher taxa. There are 
also tabular summaries of generic characters. Each volume has a unified bibliography, index and 
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list of taxa. The text is followed by a generous section of plates (50 in volume 3), with line 
drawings, light and electron micrographs. It is a pity the text could not have been organised to 
face the plates but this arrangement is doubtless cheaper and certainly preferable to random 
interspersing of text and plates. The series as a whole provides a unique overview of 
phytoplankton genera of value to any workers in the field. 

The Prymnesiophyte chapter includes, as well as the familiar oceanic coccolithophores, 
strange weakly calcified genera such as Wigwamma and Quatemariella, restricted marine genera 
such as Hymenomonas and Pleurochrysis, and their non-calcifying relatives such as Prymnesium 
and Phaeocystis. This alone gives it considerable value and it is probably the first published 
attempt at a comprehensive generic level review of the coccolithophores since Schiller. It is, 
however, rather less than authoritative, with numerous misleading comments, a few mistakes and 
much obsolete taxonomy. The examples given are a selection from the groups I know best. All 
the placolith bearing coccolithophores are included in the coccolithaceae, and although 
Emiliania, Gephyrocapsa and Crenalithus (sic) are grouped together on the generic key this is 
only on the basis that they are all small and elliptical! The Syracosphaeraceae is split into four; 
the Calciosoleniaceae, Deutschlandiaceae, Halopappaceae, and Syracosphaeraceae. Several 
redundant genera are included, for instance Halopappus, a clear synonym of Michaelsarsia. The 
small form of Neosphaera coccolithomotpha is separated as Cyclolithella annula. This distinction 
is dubious at species level distinction, and ridiculous at generic level, and in any case the type 
of C. annula was a large form specimen. Notes on genera include such oddities as a suggestion 
that Coccolithus includes three certain and six dubious species, and that Braarudosphaera is 
restricted to the Atlantic and the English Channel. 

The basic cause of this unreliability is clearly that the chapter is not a synthesis of an experts 
working knowledge but a literature review and moreover a partial one. The phycological 
literature is very well cited, but there are almost no palaeontological references (not even Perch
Nielsen 1985), and the oceanographic literature is underused. The INA bibliography was 
evidently missed since the Loeblich and Tappan bibliographies are cited with a comment that 
they need updating. 

The book is still certainly useful, and affordable, but users will regret that the extra 
collaboration needed to produce a definitive synthesis was not sought. 
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Fig.l: The eight kingdom classification of Cavalier-Smith Fig.Z: Schematic indication of possible relationships between the 
chromphyte groups, synthesised from several papers. 
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IIANDUCX>K OF CENOZOIC CALCAREOUS NANNOPLANKTON BOOK 4: HELIOLITIIAE 
(IIELICOLITHS, CRIBRILITHS, LOPADOLITHS AND OTIIERS). 

M-P. Aubry 
Micropaleontology Press, New York, 1990. pp.381. 

This book deals with the systematics, morphology, evolution and biostratigraphy of the 
genera Placozygus, Zygodiscus, Lophodolithus, Helicosphaera, Neocrepidolithus, Pontosphaera and 
Scyphosphaera. 

The first twelve pages (i-xii) are devoted to a preface and introduction which explain the 
organisation of the book, the symbols and codes used in the text, the taxonomic key and the 
philosophy behind the systematics. There is also a summary of the common characteristics of 
the genera under discussion. 

In the chapter on the genus Placozygus, the author restricts her discussion to a single species, 
Placozygus? sigmoides. 

In the following chapters, the genera Zygodiscus, Lophodolithus, Helicosphaera, 
Neocrepidolithus, Pontosphaera and Scyphosphaera are discussed in detail and the author 
illustrates all the published species assigned to the above genera. Evolutionary lineages of 
Helicosphaera, Neocrepidolithus and Scyphosphaera are illustrated (the latter two were adopted 
from Perch-Nielsen, 1981b and Perch-Nielsen, 1985 respectively). 

The information presented is mainly confined to a literature survey and contains very little 
original research material. No biometric or quantitative studies have been made on any group 
by the author. A biometric study on the Scyphosphaera, Helicosphaera (H carteri) or 
Pontosphaera would have been particularly useful. In our opinion, a figure showing line drawings 
of the holotype of every Scyphosphaera in transparent paper would be helpful for specialist 
readers. 

Considerable effort has been expended in compilation of this book and an extensive review 
of published information has been undertaken. This book is a very useful reference, particularly 
for the non-specialist, the beginner, and specialists who are not routinely working on the genera 
discussed. The integration of subsequent observations and illustration of the original description, 
the recognition of synonomies, discussion of certain taxonomic problems together with the 
stratigraphic ranges of species and lineages, are the greatest assets of this book. However, the 
usefulness of the book as a reference volume for the specialist already working on the genera 
discussed has, to a certain extent, been reduced by the availability of works such as the 
Catalogue of Calcareous Nannofossils by A Farinacci and Cenozoic Calcareous Nannofossils 
(in Plankton Stratigraphy) by Perch-Nielsen (1985). 

We have objections on several specific points some of which are given below. 

1. Photographic illustrations are not clear and in particular the SEM micrographs do not show 
sufficient detail (e.g. imbrication of elements). 

2. We found the use of the term bar/bridge very confusing since it is used in exactly the 
opposite way to Theodoridis (1984). In this book the bar is in optical continuity with the 
basal plate whilst the bridge exhibits optical discontinuity with the basal plate. 

3. According to the author, imbrication of elements in the flange is dextral in all genera 
discussed in this book. 

56 

"Dextral imbrication: the condition in a heterococcolith in which each segment overlaps the 
one to the right when viewed from the center of the cycle. Ant. sinistral imbrication". 
(Glossary of Geology, Bates and Jackson, 1980). 
According to the above definition the flange is made up of sinistrally imbricated elements 
in Lophodolithus, Pontosphaera, Zygodiscus, Helicosphaaera and Scyphosphaera, whilst 
dextrally imbricated elements are present in P?. sigmoides (not in Placozygus; see below) 
and Neocrepidolithus. 

In our opinion, the direction of imbrication in the flange or distal cover is of critical 
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importance for taxonomic studies and therefore must be identified correctly. It is on this 
basis that we can separate Mesozoic taxa from similar Tertiary forms since most of the 
Mesozoic forms exhibit dextrally imbricated elements in their flange. 

It must also be stated here that imbrication does not change depending on whether we look 
from proximal or distal view; unlike coiling direction which alters depending on the point 
of observation. 

4. Figure 1 suggests that Helicosphaera species with a 'bar' belong to the Zygodiscaceae, but 
without a bar to the Pontosphaeraceae. This does not make sense systematically. 

5. P?. sigmoides is wrongly placed within the genus Placozygus which by definition has 
juxtaposed elements in its flange (protolith). In contrast, P?. sigmoides has dextrally 
imbricated elements in its flange ( zeugoid/loxolith ). This book would have been the ideal 
place to assess these taxonomic differences and to erect a new genus to include P?. sigmoides 
which does not easily fall into any known genus. 

6. Z?. pamerolii is not related to Zygodiscus because of major structural differences. The latter 
genus has sinistrally imbricated elements in its flange while Z?. pamerolii (P. emergeri of 
other authors) has dextrally imbricated elements. In the book, however, their relationship 
is rejected on the grounds of the large interval of time between their occurrences rather 
than the above mentioned criteria. 

7. The introduction to the genus Helicosphaera appears to contain several errors: 
- p. 42, fig. 3: the orientation of the bridge in H. obliqua is incorrect in distal view. 
- p. 55, table 2: the wing type OS (overlapping with spur) is indicated as 0 (overlapping) 
only. 
- p. 62-63, the determination key contains the following mistakes: 
H. intermedia has a transverse bar perpendicular to the long axis according to the key, but 
in table 1 and on the pictures it is parallel to the long axis. 
H. moorkensii and H. gertae are placed in group IV with a bridge, but according to table 2 
they have no bridge. 

8. p. 53: naming the types of distal cover and types of interference figure as separate 
characteristics does not make sense, since one is the result of the other. 

9. "If the H. sellii LAD appears to be reliable, the use of H. recta and H. ampliaperta are open 
to criticism". We sincerely do not understand the philosophy behind the above sentence. 
Does that mean that in one genus if one species is a poor marker it automatically makes 
all other species poor markers. 

10. The author has introduced parallel evolutionary lineages within the genus Helicosphaera. 
Although, we are not fully convinced of this, this situation may be possible. However, if the 
author is positive that Helicosphaera is hiphyletic she should subdivide it into two genera. 

11. The author then puts very strong emphasis on the occurrence of species of Helicosphaera 
in the Paleocene, and therefore rejects Lophodolithus as the ancestor of Helicosphaera. 
Helicosphaera is recorded by Haq (1971) in the Middle Paleocene of Iran and we also 
observed it in sediments of the same age from Pakistan but as a result of contamination 
(burrowing). We have yet to be convinced of the in situ occurrence of Helicosphaera in the 
Paleocene. Therefore we still believe Lophodolithus is the ancestor of the genus 
Helicosphaera (with bar). 

12. p. 65: wrong citation: Helicosphaera seminulum is quoted as (Bramlette & Sullivan) J afar & 
Martini, but this is not a new combination, nor a new rank! By introducing H. seminulum 
seminulum Bramlette & Sullivan also automatically introduced H. seminulum, so Jafar & 
Martini have nothing to do with that and should not be cited. 
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13. p. 183: Discolithina millepuncta Gartner should read Pontosphaera messinae Bartolini. 

14. To illustrate the confusion in terminology, an example serves on p. 69: 
(H. gartneri): 'proximal plate is of type 11 with bar', while type 11 is defined as being without 
a bar! The preface says that original descriptions will be edited to use more appropriate 
terminology: this should have been done here. 

15. H. tmncata has priority over H. recta (ICBN article 60 states that "In no case does a name 
have priority outside its own rank"). 

16. We are not convinced that the forms N?. biskayae and N?. bukryi belong to the genus 
Neocrepidolithus. Since they have a distal cover, they should be transferred to another genus. 

17. Neocrepidolithus has dextrally imbricated elements in its flange as in Crepidolithus. In 
Romein (1977) it is wrongly described as having clockwise imbricated elements (sinistral) 
and this definition has been adopted in this study. 

18. In our opinion Transversopontis is justifiably separated from Pontosphaera. The former has 
two large performations and a strut in the distal cover whilst Pontosphaera lacks both. 
Moreover, stratigraphically Transversopontis is restricted to the Palaeogene whilst 
Pontosphaera ranges from Palaeogene to Recent. 

19. "Finally, if distinction of Transversopontis was justified solely by the presence of two 
perforations then, for the sake of consistency, it would be necessary to subdivide 
Helicosphaera into two genera". 

Is there any rule that says that we have to apply the same criteria for every genus. We 
should be flexible enough to use various criteria to erect species of genera as long as it helps 
us to organise the taxonomy better. 

We do strongly believe that our above comments do not reduce the value of the book, since 
a vast amount of data is presented for the convenience of the nannopalaeontologist. We 
~trongly recommend this book to any eo-workers particularly those who do not subscribe to the 
Catalogue of Calcareous Nannofossils by Farinacci. 

Osman Varol, The Robertson Group, Llandudno, Wales and Shirley van Heck, NAM, Assen, The 
Netherlands 

58 INA Newsletter 12!3 - 1990 



TilE ICBN: THINGS YOU NEED TO KNOW- 3 
Shirley E. van Heck, NAM, Assen, The Netherlands 

Article 4.1 of the ICBN states that " ...... A plant may ... be assigned to taxa of the following ranks 
(in descending sequence) regnum, subregnum, divisio, subdivisio, classis, subclassis, ordo, subordo, 
familia, subfamilia, tribus, subtribus, genus, subgenus, sectio, subsectio, series, subseries, species, 
subspecies, varietas, subvarietas, forma, subforma". Having dealt with specific epithets in the last 
two issues we shall now look at names of taxa below the rank of species. These are dealt with 
in articles 24 to 27. 

ARTICLE 24 
24.1: The name of an infraspecific taxon is a combination of the name of a species and an 

infraspecifzc epithet connected by a term denoting its rank. 

An item often overlooked in this respect is that the infraspecific epithet should be preceded 
by a term denoting its rank. This applies not only when introducing a new taxon, but also when 
quoting one, since the article clearly states that this term is part of the name. Therefore 
Discoaster tanii nodifer, which is commonly used, should correctly be cited as Discoaster tanii 
subsp. nodifer. Although the term is abbreviated as 'subsp.' in the ICBN, the abbreviation 'ssp.' 
is also very common, and can be considered correct. 

24.2: lnfraspecific epithets are formed as those of species and, when adjectival in form and not used 
as substantives, they agree grammatically with the generic name (see Art.32.5). 

This implies that the rules outlined in the previous two issues also apply here. When 
quoting the reference to Art.32.5 in the previous issues, I neglected to quote the article and 
show its relevance, so I shall do so here: 

325: Names published with an incorrect Latin termination but otherwise in accordance with this 
Code are regarded as validly published; they are to be changed to accord with Arts. 17-19 [super
generic taxa], 21 [genera], 23, and 24, without change of the author's name or date of publication 
(see also Art. 73.10) 

The explanations in square brackets are mine, the remaining Articles have been discussed 
previously. We will return to this article in a future issue. 

Arts. 24.3 and 24.4 have never caused us problems, and I doubt they ever will, so I shall omit 
them. The next one, however, has caused confusion: 

24.5: Infraspecific taxa within different species may bear the same epithets; those within one species 
may bear the same epithets as other species (but see Rec. 24B ). 

This recommendation is: 
24B.l.: Authors proposing new infraspecific epithets should avoid those previously used for species 

in the same genus. 

This is a sensible recommendation, because a change of rank might otherwise cause problems. 
However, if the recommendation is not followed, the Article clearly states that this does not 
make the taxon invalid. Example: Marthasterites nunnii was introduced as a nomen novum for 
Marthasterites bramlettei. The latter was thought to be invalid because of the existence of the 
name Marthasterites furcatus var. bramlettei. Because of Art.24.5, however, it is clear that M 
bramlettei is the correct name, and M nunnii is superfluous (for a fuller discussion see van Heck 
1980). If, however, M furcatus var. bramlettei were to change rank, a new name would have to 
be introduced for it to avoid homonymy. 

In this context it might be useful to quote one more article: 
64.4: The names of two subdivisions of the same genus, or of two infra specific taxa within the same 

species, even if they are of different rank, are treated as homonyms if they have the same epithet and 
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are not based on the same type. The same epithet may be used for subdivisions of different genera, 
and for infraspecific taxa within different species. 

Example: If someone were to introduce 'Marthasterites furcatus ssp. bramlettei' then this should 
be regarded as a homonym of the variety with the same name, and the subspecies would be 
illegitimate. 

ARTICLE 25 
25.1: For nomenclatural purposes, a species or any taxon below the rank of species is regarded as 

the sum of its subordinate taxa, if any. In fungi .... 

This is a straightforward, but important concept. Example: Quoting Umbilicosphaera sibogae 
implies U. sibogae var. foliosa as well as U. sibogae var. sibogae. 

ARTICLE 26 
26.1: The name of any infraspeci[tc taxon that includes the type of the adopted, legitimate name of 

the species to which it is assigned is to repeat the specific epithet unaltered as its final epithet, but 
not followed by an author's name (see Art.46). Such names are termed autonyms (Art.6.8; see also 
Art.7.21). 

26.2: The first valid publication of a name of an infraspecific taxon that does not include the type 
of the adopted, legitimate name of the species automatically establishes the corresponding autonym 
(see also Arts. 32.6 and 57.3) 

In practice two problems seem to occur: 
1. Not all authors are aware that in introducing a subspecies they automatically introduce the 
subspecies containing the type of the species. Thus, they are inclined to formally describe both 
subspecies (which is useful but not necessary), and to attach their name to the autonym (which 
is incorrect). 
2. Citation of the name of the subspecies containing the type causes some problems. The code 
states that the subspecies should not be followed by an authors name, but in Art.32.6 (referred 
to in Art. 26.2) it says that this subspecies is established at the time the other subspecies was 
introduced. Fortunately, the code gives examples (Art.57, Ex. 7-9) which we might translate as 
follows: 

In introducing Lithraphidites alatus Thierstein 1972 ssp. magnus the authors automatically 
introduced Lithraphidites alatus Thierstein ssp. alatus (the fact that they actually named the 
latter is irrelevant), which they cited as Lithraphidites alatus alatus Thierstein, 1972. According 
to the ICBN the subspecies should have been cited as follows: Lithraphidites alatus Thierstein 
1972 ssp. alatus (1987) and Lithraphidites alatus Thierstein ssp. magnus Covington & Wise 1987. 
The addition of (1987) behind the autonym is the correct citation as given in the code, but it 
may be confusing, and perhaps better omitted. 

The other articles referred to are not relevant at this point. The last article on infraspecific 
epithets should be well known: 

ARTICLE 27 
2Zl: The final epithet in the name of an infraspecific taxon may not repeat unchanged the epithet 
of the correct name of the species to which the taxon is assigned unless the two names have the same 
type. 

Finally there are some detailed recommendations on dealing with subordinate taxa. Since in the 
nannoplankton literature more than one rank below the level of species is exceptional, I shall 
omit these. If, however, you do want to subdivide subordinate taxa, make sure you have the right 
order, as given above (Art.4.1). 
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erratum 
In the previous issue I used as an example the name hintii after van Hinte. This should, of 
course, be hintei. 
Thank you, Katharina, for pointing this out to me! 
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A NEW TECHNIQUE FOR CONSTRUCTING CAMERA-READY RANGE CHARTS 
USING A MACINTOSH COMPUTER 

Wuchang Wei, Geology Dept., Florida State Univ., Tallahassee, FL 32306, USA 

Nearly every micropaleontologist needs to construct distribution charts of fossil taxa from time 
to time. Unfortunately, preparing camera-ready range charts (required by most journals) has 
been quite difficult or costly, because there has not been a computer program that can do the 
entire job. The popular Checklist 11 or spread sheet programs, such as Lotus 1-2-3 or Microsoft 
Excel, can easily be used to present abundance data but cannot deal with zonal names and 
boundaries, let alone show hiatuses, lithology, etc. This is probably the major reason that Ocean 
Drilling Program has required its contributors to submit all figures in camera-ready form except 
for range charts, which are believed to be too difficult for contributors to prepare in finished 
form. 

I have recently developed a new technique to construct camera-ready range charts with ease 
using a Macintosh computer (Macintosh Plus or later models). It takes advantage of Microsoft 
Excel* for entering abundance data and MacDraw 11** for drawing zonal boundaries, lithology, 
magnetostratigraphy, etc. It is quick, extremely versatile, and can produce more sophisticated 
range charts than one might expect from a personal computer. A specimen range charts 
prepared using this new technique is included. The procedure is as follows. 

1. Turn off the Multifinder (if it is on) unless your computer has a very large memory. 
This is done by going to the special menu to select set startup, followed by clicking 
finder. Then restart the machine. 

2. Open Microsoft Excel. 
3. Highlight the first column, then go to the Format menu to execute change column width 

to make the column wide enough to accommodate your sample names. Repeat this 
step for the second column if you wish to enter sample depth data. Highlight enough 
columns on the right to accommodate the number of species. Change the widths ~o "1" 
to allow for the entry of species abundance data. 

4. Enter sample numbers and species abundance data as you would fill in a form (you will 
enter the species names later in MacDraw 11). Remember that you can move columns 
around to order them by first occurrence, last occurrence, taxonomic groups etc. as you 
desire. 

5. Turn off print row and column headings and print gridlines, followed by click on OK. 
6. Go to the File menu and save the document. 
7. Highlight (press the mouse and drag) the area of the chart that you want to include in 

your final range chart (exclude column number and row number). 
8. While holding down the Shift key, go to the Edit menu and execute copy picture. 
9. Click as shown when printed followed by OK. 

10. Go to the File menu and exit and Excel program. 
11. Double-click the MacDraw 11 icon to open this program. 
12. Select Turn autogrid off from the Edit menu, and chose the Times or Helvetica font 

from the Font menu. 
13. Go to the Edit menu and execute paste to transfer your chart to MacDraw 11. 
14. Select Group from the Arrange menu, and then chose the Times or Helvetica font. 
15. Drag the pasted chart to the proper position so that you have room for adding species 

and zonal names, litho-, magneto-stratigraphy, etc. 
16. Click a blank area to unselect the pasted picture, and then select italic from the Style 

menu. 
17. Double-click the text tool (A), and type the species names in column but remember to 

click the next line to start typing next species (Do not worry about alignment or even 
line spacing but try to achieve a small line spacing). Click the pointer tool (arrow on 
the left upper screen) when finished typing all the species names. 

18. Select all the species names by pressing and dragging the mouse to enclose the names, 
group them from the Arrange menu, then select rotate. 

19. Grab a corner, rotate it counterclockwise 90°, and then drag it to its intended position 
so that the first species name lines up with its corresponding data column. 

20. Execute Ungroup from the Arrange menu, then click on the pointer tool. 
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21. Drag the last species name so that it lines up with the last data column. 
22. Press and drag the mouse to enclose all the species names and select alignment from 

the Arrange menu. Click align and bottom on the right side, distribute on the bottom, 
followed by OK This will align the names with their respective columns. 

23. Use the text, line, and other tools to complete the range chart the way you like it. Refer 
to the MacDraw II manual if you wish to perform more complicated tasks. You can be 
assured that the MacDraw II program will allow you to draw virtually anything you 
need. 

I recommend using a 0.2 size pen for lines and printing the range charts at -75% of the 
original size. This not only saves page space, but also makes the range charts more eye 
appealing. 

If you have a DOS Mounter program on your Macintosh computer, you can open a 
spreadsheet file (such as Lotus 1-2-3 for IBM computers) directly from the Excel program, edit 
it if necessary, and save it in Excel. This is very useful if you have already entered or prefer to 
enter your data in an IBM (or compatible computer, and you only use a Macintosh computer 
to do the final touch on the range chart that cannot be done using a IBM computer. 

The disclosure of this new technique is intended as a service to the community. You are 
welcome to contact me (my electronic mail address is: Wei@FSU.Bitnet) if you have any 
questions, but please know that I may not be able to provide detailed answers to every question. 

Acknowledgments: I wish thank Professor S.W. Wise for suggesting that I write this article for 
the INA Newsletter and for reviewing the manuscript. Sarah Wise, a high school student with 
no previous Macintosh experience, helped test the technique by preparing the range charts 
shown in Wei (this volume). This study was supported by an equipment grant from the Amoco 
Foundation and by NSF grant DPP8917976 to S.W. Wise. 

• Microsoft Excel is a program for Macintosh computers and can be purchased from its 
producer: Microsoft Corporation, 16011 NE 36th Way, Box 97017, Redmond, WA 98073-9717, 
USA 
•• MacDraw II is a program for Macintosh computers and can be purchased from its producer: 
Claris Corp., 440 Clyde Avenue, Mountain View, CA 94043, USA 
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Fig. 1. Stratigraphic distribution of Paleogene calcareous narmofossil species and its correlation with the magnetostratigraphy 
of Berggren et al. (1984) for DSDP Hole 516F. Black interval indicates normal polarity; white interval indicates reversed 
polarity; and shaded interval denotes no paleomagnetic data. For narmofossil abundance, V=very abundant; A=abundant; 
C=common; F=few; and R=rare. For preservation of narmofossil assemblages, M =moderate; and P=poor. 
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NON-CORRELATION OF NANNOFLORAL COMPOSffiON WITH ISOTOPIC 
VARIATION IN CENOMANIAN CHALK-MARL RHYTHMS, 

SOUTH-EASTERN ENGLAND 
Jackie Bumett, Department of Geological Sciences, University College London 

INTRODUCTION 
Ditchfield & Marshall (1989) noted a difference in 0-isotope composition between chalks and 
marls in Cenomanian chalk-marl rhythmic bedding of the Kent coast, south-eastern England. 
The chalks gave consistently lighter values of 6180 than the marls. A survey of the nannofloras 
showed no systematic variation through the section (see below), this enabled the authors to 
deduce that 180 composition was not affected by differences in biogenic fractionation of 
different coccolithophorid groups. They concluded that the 180signal recorded cyclical variations 
in the temperature of photic zone water (probably 23°C for marl deposition and 25°C for chalk 
deposition, with a maximum variation of 4.5°C), which was also recorded as cyclical nannofloral 
productivity. Due to the lack of consistent variation the nannofossil data was not included in the 
original paper, but as a matter of general interest to other workers in this field, I felt it would 
be worthwhile to publish it here. 

NANNOFLORAL RESULTS 
Simple counts of approximately 500 specimens per smear-slide were made, the samples being 
taken from 10cm intervals over a 1.2m section ofrhythmically-bedded chalks and marls cropping 
out between Folkestone and Dover. These were entered onto the Checklist 11 range-chart 
database and a chart of relative abundances was produced (Figure 1 ). The section falls into NF 
Subzones CC9C/10A (as defined in Perch-Niclsen 1985), between the FO of Corollithion 
kennedyi and the LO of Microstaums chiastius. Fifty-six species were identified. Diversity 
fluctuated between 38 and 44 species per sample, the more consistently higher diversities 
occurring in the lower 0.5m of the section. The nannofloras are dominated by Biscutum 
ellipticum and Watznaueria bamesae throughout the section, with Discorhabdus ignotus, 
Eiffellithus turriseiffeli~ Prediscosphaera cretacea, Tranolithus orionatus and Zeugrhabdotus erectus 
being consistently represented, although not in great numbers. No systematic floral change was 
observed in relation to the lithology to account for the regular change in 6180 composition. 
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Figure 1: Nannofossil counts and stratigraphical distribution, Cenomanian chalk-marl rhythms, Kent. 
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A NEW NANNOFOSSIL ZONATION SCHEME FOR TilE BOREAL CAMPANIAN 
Jackie Bumett, Dept. of Geological Sciences, University College London. 

IN1RODUCTION 
In 1975, the Institute of Geological Sciences (now the British Geological Survey) drilled the 
Trunch Borehole (located in north-eastern Norfolk, eastern England) in order to sample as 
complete a section of the Upper Cretaceous on the British mainland as possible, to be used as 
a standard section for correlation purposes in the northern English and southern North Sea area 
(Gallois & Morter, 1975). Approximately 220m of the borehole are Campanian in age. 

As part of an extensive correlation project between macrofossil and nannofossil zonation 
schemes, approximately 260m of Campanian chalk from the Lagerdorf and Kronsmoor Quarries, 
located near Hamburg, north-western Germany, were examined for their nannofloral content. 

It became apparent that the Campanian nannofloras of the two areas are comparable, both 
containing a number of Boreal-restricted forms, with a number of characteristically Tethyan 
zonal marker species being absent. The application of Sissingh's (1977, 1978) standard numbered 
zonation scheme, supplemented by Perch-Nielsen's nannofossil event observations (1979, 1983, 
summarised in Bolli et al., 1985) fails between NF Zones CC18 and CC22B, due to the non-, 
or very rare and stratigraphically sporadic occurrences of Bukryaster hayii, Ceratolithoides 
verbeekii, Marthasterites furcatus spp., Ceratolithoides aculeus, Quadmm sissinghii, Quadmm 
trifuium and Lithastrinus grillii. Additionally, in northern chalks, where calcitic overgrowth on 
nannofossil specimens tends to obscure fine detail, it is sometimes very difficult to differentiate 
between Reinhardtites levis and R. anthophoms when routinely dating by light-microscope, thus 
the identification of the bases of standard NF Zones CC22C and CC23A can be less than 
precise. 

Correlation between the identifiable Campanian NF zones of the Trunch Borehole and the 
German quarries revealed a number of interstitial nannofloral events which bridge the gap in 
Sissingh's (1977) scheme and provide a workable alternative for the Boreal region, possibly 
including the North Sea area. The new zones are fitted within the framework of Sissingh's 
scheme (but are distinguished from his zones by the prefix B, for Boreal), in order that their 
relative positions, with respect to the standard cosmopolitan events, are continuous. Integrated 
macro- and microbiostratigraphical data on the sections involved will be published elsewhere. 

NANNOFOSSIL BIOZONATION 
New NF Zones CC/B18 to CC/B22 replace Sissingh's (1977) NF Zones CC18 to CC22, whilst 
Sissingh's Zone CC17 is divided into Subzones CC/B 17a, CC!B 17b and CC/B 17c, and his 
Subzone CC23A is subdivided into CC/B23Aa, CC/B23Ab and CC/B23Ac, herein. The zones 
are defined in Appendix 2. 

Figure 1 shows the correlation between the English and German nannofossil events used to 
define the new (sub-)zones. The stage and macrofossil zonation of the Trunch Borehole is 
attributed to Morter (1984, unpublished B.G.S. data). Stage and macrofossil data was taken from 
Schulz et al. (1984) for the German material. Age definitions for the new (sub-)zones are 
estimated from the German scale, as this has a more refined macrofossil zonation control than 
has the Trunch Borehole. 

Sissingh's (1977) standard nannofossil zones are correlated with the new Boreal zones and, 
for interest, with the Campanian part o.f the Sr-isotope curve of McArthur et al. (in press: 
based on the Trunch Borehole) in Figure 2. A high degree of age-refinement was not possible 
in the Trunch Borehole, with which to correlate the Sr-isotope curve. From the correlation of 
nannofossil data between England and Germany, more refined age-assignments can be 
extrapolated for the curve. A nannofossil species index is given in Appendix 1. 

DISCUSSION 
A number of industry-orientated Boreal nannofossil zonation schemes have been produced for 
the Late Cretaceous, based on North Sea well samples. These schemes suffer from having little, 
or no, biostratigraphical control with- which to correlate onshore material, and from the 
nannofloras being generally much less well preserved than in onshore material. Mortimer (1987) 
produced a Cenomanian to Maastrichtian scheme for the southern Norwegian and Danish 
North Sea area, and equated his zones to Sissingh's (1977) scheme by extrapolation. In 
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particular, he divided the uppermost Hod and lowermost Tor Formations (representing the 
Lower and Upper Campanian, respectively) into four nannofossil zones, based on the LOs(= 
first downhole occurrences) of Orastmm campanensis, Helicolithus trabeculatus, Cylindralithus 
asymmetricus ( = C. biarcus?), Broinsonia enormis and Phanulithus ( =Calculites) obscurus. In my 
study, 0. campanensis was found not to have a correlatable LO between Germany and England, 
whilst H trabeculatus, C.biarcus and B. enormis were found to range beyond the limits defined 
by Mortimer (probably due to preservation). Varol (1989) used Mortimer's (1987) scheme with 
some additional events, one of which (the LO of Tortolithus caistorensis) approximates to the 
findings of this study. 

CONCLUSIONS 
It is hoped that the extensive geographical application of this new biozonation already evinced 
by this study is applicable to the North Sea area (although I appreciate that the new scheme 
uses mostly FOs, whereas LOs are of more use, industrially), where correlation of nannofloral 
events with macrofossil/stage data would prove useful for industrial and research purposes. 
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APPENDIX 1: NANNOFOSSIL TAXONOMICAL INDEX 
References for, and illustrations of, these species can be found in Perch-Nielsen (1985). 
Biscutum dissimilis Wind & Wise in Wise & Wind, 1977 
B. magnum Wind & Wise in Wise & Wind, 1977 
Broinsonia parca (Stradner, 1963) Bukry, 1969 
Calculites obscurus (Deflandre, 1959) Prins & Sissingh in Sissingh, 1977 
Heteromarginatus bugensis (Gorka, 1963) Crux in Crux et al., 1982 
Monomarginatus quaternarius Wind & Wise in Wise & Wind, 1977 
Neocrepidolithus cohenii (Perch-Nielsen, 1968) Perch-Nielsen, 1984a 
Orastrum campanensis (Cepek, 1970) Wind & Wise in Wise & Wind, 1977 
Prediscosphaera stoveri (Perch-Nielsen, 1968) Shafik & Stradner, 1971 
Reinhardtites anthophorus (Deflandre, 1959) Perch-Nielsen, 1968 
R. levis Prins & Sissingh in Sissingh, 1977 
Staurolithites mielnicensis (Gorka, 1957) Perch-Nielsen, 1968sensu Crux in Lord, 1982 
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Tortolithus caistorensis Crux in Crux et al., 1982 
Tranolithus orionatus (Reinhardt, 1966a) Reinhardt, 1966 

APPENDIX 2: FORMAL DESCRIPTION OF ZONES 
CALCULITES OBSCURUS PARTIAL RANGE (P.R.) ZONE (CC17) Sissingh (1977). 

Definition: FO of Calculites obscurus to the FO of Broinsonia pare a. 
Age: Late Santonian to early Campanian. 

CALCULITES OBSCURUS P.R. SUBZONE (CC/B 17a) New subzone 
Definition: FO of Calculites obscurus to the FO of Orastrum campanensis. 
Age: Late late Santonian to early early Campanian. Type locality: Lagerdorf Quarry. 

ORASTRUMCAMPANENSISP.R. SUBZONE (CC/B17b) New subzone 
Definition: FO Orastrum campanensis to the FO of Biscutum magnum. 
Age: Early early Campanian. Type locality: Lagerdorf Quarry. 

BISCUTUMMAGNUMP.R. SUBZONE(CC/B17c) New subzone 
Definition: FO of Biscutum magnum to the FO of Broinsonia parca. 
Age: Early early Campanian. Type locality: Lagerdorf Quarry. 

BROINSONIAPARCA P.R. ZONE (CC/B18) New zone 
Definition: FO of Broinsonia parca to the FO of Staurolithites mielnicensis. 
Age: Early early Campanian. Type locality: Lagerdorf Quarry. 

STAUROLITHITESMIELNICENSISP.R. ZONE (CC/B19) New zone 
Definition: FO of Staurolithites mielnicensis to the FO of Monomarginatus quaternarius. 
Age: Early to middle early Campanian. 
Type locality: Lagerdorf Quarry. 

MONOMARGINATUSQUATERNARIUSP.R. ZONE (CC/B20) New zone 
Definition: FO of Monomarginatus quaternarius to the FO of Reinhardtites levis. 
Age: Middle early to early late Campanian. Type locality: Lagerdorf Quarry. 
Remarks: Prediscosphaerastoveri FOs around the CC22B/CC22C boundary, probably within this zone, and may be 

useful in cases where the FO of Reinhardtites levis is difficult to distinguish. 
BISCUTUMDISSIMILISP.R. ZONE (CC/B21) New zone 

Definition: FO of Reinhardtites levis to the LO of Biscutum dissimilis. 
Age: Early late Campanian. Type locality: Lagerdorf Quarry. 

EIFFELLITHUSEXIMIUS P.R. ZONE (CC/B22) New subzone 
Definition: LO of Biscutum dissimilis to the LO of Reinhardtites anthophoms (or LO E. eximizlS). 
Age: Early to late late Campanian. Type locality: Lagerdorf and Kronsmoor Quarries. 

TRANOLITHUSORIONATUS (= PHACELOSUS) P.R. ZONE (CC23) Sissingh 1977 
Definition: LO of Reinhardtites anthophorus to the LO of Tranolithus orionatus. 
Age: Latest Campanian to early Maastrichtian. 

TRANOLITHUSORIONATUS P.R. SUBZONE (CC23A) Perch-Nielsen 1985 
Definition: LO Reinhardtites anthophorus to the LO of Broinsonia pare a. 
Author: Figured but not defined in Perch-Nielsen (in Bolli et al., 1985). 
Age: Latest Campanian to earliest Maastrichtian. 

HETEROMARGINATUSBUGENSIS P.R. SUB-SUBZONE (CC/B23Aa) New sub-subzone 
Definition: LO Reinhardtites anthophorus to the LO of Heteromarginatus bugensis. 
Age: Late late Campanian. Type locality: Kronsmoor Quarry. 

TORTOLITHUSCAISTORENSIS P.R. SUB-SUBZONE (CC/B23Ab) New sub-subzone 
Definition: LO of Heteromarginatus bugensis to the LO of Tortolithus caistorensis. 
Age: Latest Campanian to earliest Maastrichtian. Type locality: Kronsmoor Quarry. 

NEOCREPIDOLITHUSCOHENII P.R. SUB-SUBZONE (CC/B23Ac) New sub-subzone 
Definition: LO of Tortolithus caistorensis to the LO of Broinsonia parca. 
Age: Early early Maastrichtian. Type locality: Kronsmoor Quarry. 
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Figure 1: Correlation between English and 
German Boreal nannofossil events (N.B. 
macrofossil zones do not necessarily 
correlate). *After Sissingh (1977, 197A) 
and Perch-Nielsen (1979, 1983, 1985). 
Species indicated by numerals explained 
in Figure 2. 
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Figure 2: New Boreal zonation scheme correlated with the 
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press). 
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BIBLIOGRAPHY AND TAXA OF CALCAREOUS NANNOPLANKTON - 16 

Compiled by William G. Siesser 

ACKLESON, S., BALCH, W.M. & HOLLIGAN, P.M. 
White waters of the Gulf of Maine. 

Oceanography, 1 (2): 18-22, 4 figs. 
V V ~ ~ 

1 9 8 8 Living; Ecol. 
QUAT. 
Atlantic N. 

ALADZOVA-HRISCEVA, K. & PAVSIC, J. 1 9 9 0 Strat.; (Syst.) 
TERT.L. Nummulites and calcareous nanno-fossils from lower Eocene beds in the area 

" of Veliko Tarnovo (north Bulgaria) 
Geologija, 31,32: 209-217, 4 figs., 2 pis. 

ARREOLA, H.J.F., & VINAS, G.F. 
Estudio del nanoplancton calczreo (cocolitoforidos y discoasteridos) del 
Mioceno medio de la Formacion Tuxpan, Cuenea de Tampico-Misantla, 
Mexico. 

Paleontol., 1(1): 88-97, 4 figs. 
(In Spanish with English abstract.) 

AUBRY, M.-P. 
Handbook of Cenozoic Calcareous Nannoplankton, Book 4: Heliolithae 
(Helicoliths, Cribriliths, Lopadoliths and others). 

Micropaleontology Press, Amer. Mus. Nat. Hist., New York, 381 pp., 
40 text-figs., 1403 figs. 

AUBRY, M-P., GRADSTEIN, F.M. & JANSA, L.F. 
The late early Eocene Montagnais bolide: no impact 
on biotic diversity. 

Micropaleo., 36(2): 164-172, 3 figs., 2 tbls. 

Europe E. 

1 9 8 7 Strat. 
TERT.U. 
America C. 

1 9 9 0 Strat.; Syst., 
Overview 
TERT. 

1 9 9 0 Strat. 
TERT.L. 
America N. 

BALDAUF, J.G., CLEMENT, B., AKSU, A.E., DE VERNAL, A, 1 9 8 9 Strat. 
TERT.U.; 
QUAT. 
Atlantic N. 

FIRTH, J., HALL, F., HEAD, M.J., JARRARD, R., KANINSKI, 
M.A., LAZARUS, D., MONJANEL, A.L., BERGGREN, W.A., 
GRADSTEIN, F., KNUTTEL, S., MUDIE, P. & RUSSELL, M.D. 

Magnetostratigraphic and biostratigraphic synthesis of Ocean Dilling Program 
Leg 105: Labrador Sea and Baffin Bay. 

In: Srivastava, S.P., Arthur, M., Clement, B. et al., Proc. 
ODP Sci. Results, 105: 935-956, 9 figs., 4 tbls. 

7 BARBIN, V., HERB, R. & DECROUEZ, D. 1989 Strat. 
Les nannofossiles calcaires du passage Cretace/ Tertiaire dans le val Gallina 
(Verone, ltalie du Nord). 

Rev. Paleobiologie, 3: 63-79, 4 figs., 5 pis. 
(In French with English abstract). 

8 BRALOWER, T.J. 
Lower Cretaceous calcareous nannofossil stratigraphy 
of the Great Valley sequence. 

Amer. Assn. Petrol. Geol. Bull., 74(5): 618. 

9 BRALOWER, T.J., LECKIE, M., SLIT ER, W ., ALLARD, D., 
ARTHUR, M. & SCHLANGER, S. 

Oceanwide anoxia in the early Aptian. 
Amer. Assn. Petrol. Geol. Bull., 74(5): 618-619. 
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CANTU-CHAPA, A. ... ,. ,. 1 9 8 9 
Precisiones sobre el limite Jurasico-Cretacico en el 
subsuelo del este de Mexico. 

Rev. Soc. Mex. Paleontol., 2(1 ): 26-69, 21 figs., 2 pis. 
(In Spanish with English abstract.) 

CHANNELL, J.E.T., RIO, D., SPROVIERI, R. & GLAC(ON 1 9 9 0 
Biomagnetostratigraphic correlations from Leg 1 07 in the Tyrrhenian Sea. 

In: Kastens, K.A., Mascle, J. et al., Proc. ODP Sci. Results, 
107: 669-682, 9 figs., 1 tbl. 

CHAUDHURI, S. 1 9 9 0 
Coccoliths in Barakar Formation of Ramgarh Coalfield, Bihar. 

J. Geol. Soc. India, 35: 520-523, 2 figs. 

CLARK, M.W. 1 9 9 0 
Cenozoic calcareous nannofossils from the lesser Antilles forearc region and 
biostratigraphic summary of Leg 110. 

In: Moore, J.C., Mascle A., et al., Proc. ODP Sci. Results, 110: 
129-140, 3 figs. 

COOPER, M.K.E. 1 9 9 0 
A revision of the stratigraphic history of the Genus Stephanolithion. 

INA Newsl., 12(2): 17-20, 1 fig. 

DOWSETT, H.J. 1 9 8 9 
Documentation of the Santonian- Campanian and Austinian- Tayloran stage 
boundaries in Mississippi and Alabama using calcareous microfossils. 

U.S. Geol. Surv. Bull. 1884, 20 pp., 7 figs., 3 tbls., 7 pis. 

DOWSETT, H.J. & CRONIN, T.M. 1 9 9 0 
High eustatic sea level during the middle Pliocene: evidence from 
the southeastern U.S. Atlantic Coastal Plain. 

Geology, 18(5): 435-438, 3 figs., 1 tbl. 

DUAN, W. 1 9 8 8 
Mid-late Tertiary sedimentary environment in continental margin of South 
China Sea. 

In: P. Whyte, J.S., Aigner, N.G., Jablonski et al. (eds.), The 
Palaeoenvironment of East Asia from the Mid-Tertiary, Proc. 2nd Cont., Univ. 
Hong Kong, 1: 255-264, 4 figs. 

Strat. 
JURA.U.; 
CRET.L. 
America C. 

Strat. 
TERT. U.; 
QUAT. 
Mediterr. 

Strat; Syst. 
PREJURA. 
Asia E. 

Strat. 
TERT.;QUAT 
Atlantic N. 

Strat. 
JURA. 

Strat.;(Syst 
CRET.l. 
America N. 

Strat. 
TERT.U. 
America N. 

Strat. 
TERT. 
Asia E. 
Pacific C. 

DUCKLOW, H.W. 
Joint Global Ocean Flux Study: the 1989 North Atlantic Bloom Experiment. 

1 9 8 9 Living; Sedin 
Ecol. 

Oceanography, 2(1): 4-7, 2 figs. 

EIDE, L.K 1 9 9 0 
Distribution of coccoliths in surface sediments in the Norwegian-Greenland Sea. 

Marine Micropaleo., 16: 65-75, 5 figs., 4 tbls. 

EVANS, A.L. 1 9 8 8 
Neogene tectonic and stratigraphic events in the Gulf of Suez Rift Area, Egypt. 

Tectonophysics, 153(1-4): 235-247, 10 figs. 
[Nannofossils by J. Steinmetz and W. Lohman]. 
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FARINACCI, A. 1 9 8 9 
Catalogue of Calcareous Nannofossils, vol. 13 

Edizioni Technoprint - Homa, 250 pp. 

FINGER, K.L, LIPPS, J.H., WEAVER, J.C.B., & MILLER, P.L. 1 9 9 0 
Biostratigraphy and depositional environments of calcareous microfossils in 
the lower Monterey Formation (lower to middle Miocene), Graves Creek area, 
central California. 

Micropaleo., 36(1): 1-55, 5 figs., 3 tbls., 15 pis. 

FIRTH, J. 1 9 8 9 
Eocene and Oligocene calcareous nannofossils from the Labrador Sea, ODP 
Leg 105. 

In: Srivastava, S.P., Arthur, M., Clement, B., et al., Proc. ODP Sci. 
Results, 105: 263-286, 3 figs., 5 tbls., 5 pis. 

, 
FLORES, J.A., SIERRO, F.J., CIVIS, J., FRANCES, G., 1 9 8 9 
VALLE, M.F. & GONZALES DELGADO, J.A. 

Plancton y bentos calcareos del Neogeno superior en sondeos oceanicos 
(DSDP) del Atlantico NE y sistema Betico - rifeno. 

Geogaceta, 6: 84-87, 2 figs. 
(In Spanish with English abstract). 

FORTUIN, A.R., DE SMET, M.E.M., HADIWASASTRA, S., 1 9 9 0 
VAN MARLE, L.J., TROELSTRA, S.R. & TJOKROSAPOETROS, S. 

Late Cenozoic sedimentary and tectonic history of south Buton, Indonesia. 
J. Southeast Asian Earth Sci., 4(2): 107-124, 11 figs., 1 tbl. 

FRANCES, G., SIERRO, F.J., CIVIS, J., & FLORES, J.A. 1 9 9 0 
Variacion en las asociaciones de foraminfteros bentonicos abisales en el DSDP 
Site 135 durante el Pleistoceno superior. 

Rev. Soc. Geol. Espana, 3(1-2): 127-128, 5 figs. 
(In Spanish with English abstract). 

GALLAGHER, LT. 1 9 9 0 
Calcareous nannofossil biozonation of the Tertiary of the North Sea Basin. 

Newsl. Strat., 22(1): 21-41., 4 figs. 

GLAC(ON, G., RIO D. & SPROVIERI, R. 1 9 9 0 
Calcareous plankton Pliocene-Pieistocene biostratigraphy in the Tyrrhenian 
Sea (western Mediterranean, Leg 1 07). 

In: Kastens, K.A., Mascle, J. et al., Proc. ODP Sci. Results, 107: 
683-693, 5 figs., 3 tbls. 

GOROSTIDI, A., FLORES, J.A. & LAMOLDA, M.A. , 1 9 9 0 
Aspectos tafoJlomicos y paleoecologicos de la nanoflora calcarea del Cretacico 
superior de Alava accidental. 

In: Llovera, J.C. & Flores Villarejo, J.A. (eds.). Aetas de 
Paleontologica. pp. 159-171, 3 figs., 1 pi. 
(In Spanish with English summary) 
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1 GRADSTEIN, F.M. & LUDDEN, J.N. & SHIPBOARD SCIENTIFIC 

PARTY 
Proc. ODP lnit. Repts., vol. 123 (Argo Abyssal Plain/Exmouth Plateau; Sites 
765-766). 716 pp. 

(Nannofossils by P.R. Sown, M.J. Moran & J. Mutterlose] 

2 HAY, B. & HONJO, S. 
Particle depositon in the present and Holocene Black Sea. 

Oceanography, 2(1): 26-31, 5 figs. 

3 HOEPFFNER, N. & HAAS, LW. 
Electron microscopy of nanoplankton from the North Pacific Gyre. 

J. Phycol., 26: 421-439, 47 figs., 1 tbl. 
V V ~ 

4 JELEN, B., MERVIC, H., HORVAT, A. & PAVSIC, J. 
Changes of microfossil assemblages in the Oligocene of the Zasavje region. 

Geologija, 31,32: 329-345, 6 figs. 
(In Bulgarian with English abstract) 

1990 Tech; (Strc 
CRET.L. to 
QUAT. 
Indian 

1989 Living;Sedi 
Ecol. 
QUAT. 
Mediterr. 

1990 Living; Eco1 
QUAT. 
Pacifc N. 

1990 Strat.; Ecol. 
TERT.L. 
Europe E. 

5 JIANG, M.-J., & ROBINSON, E. 1 9 8 7 Strat. 

6 

Zonation of some Jamaican Cretaceous rocks using calcareous nannofossils. CRET.L.-M. 
1Oth Caribbean Geol. Cont., Cartagena, Colombia, transactions, America C. 
pp. 243-249, 8 figs. 
[Conference was held in 1983; the transactions were published in 1987] 

JOYCE, J.E. 1 9 9 0 
High-resolution planktic stable isotope record and spectral analysis for the 
last 35 m.y.;Ocean Drilling Program Site 625, northeast Gulf of Mexico. 

Paleoceanog., 5(4): 507-529, 4 figs., 6 tbls., 2 pis. 

I sot. 
TERT.U.;QUJ 
Atlantic C. 

7 KLEIJNE, A. & JORDAN, R.W. 1 9 9 0 Syst. 

8 

9 

1 0 
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Proposed change to the classification system of living coccolithophorids. 11. 
INA Newsl., 12(2): 13. 

KLEIJNE, A., KROON, D. & ZEVENBOOM, W. 1 9 8 9 
Phytoplankton and foraminiferal frequencies in northern Indian Ocean and 
Red Sea surface waters. 

Netherlands J. Sea Res., 24(4): 531-539, 4 figs. 

KNUTTEL, s., RUSSELL, M.D. & FIRTH, J.V. 1 9 9 0 
Neogene calcareous nannofossils from Leg 1 05: implications for Pleistocene 
paleoceanographic trends. 

In: Srivastava, S.P, Arthur, M., Clement, B., et al., Proc. ODP Sci. 
Results, 105: 245-262, 4 figs., 3 tbls., 2 pis. 

LEWIS, J.F., VESPUCCI, P., ROBINSON, E., JIANG, M.-J. ET AL. 1 9 8 7 
Paleocene stratigraphy of the Padre Las Casas and adjacent areas in the southeast 
Cordillera Central Dominican Republic. 

1Oth Caribbean Geol. Con f., Cartagena, Colombia, transactions, 
pp. 229-235, 4 figs. 
[Conference was held in 1983; the transactions were published in 1987.] 

Living; Ecol 
QUAT. 
Indian 

Strat.; Syst. 
TERT.U;QUA 
Atlantic N. 

Strat. 
TERT.L. 
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1 LOWENSTAM, H.A. & WEINER, S. 1 9 8 9 Bioi. 

2 

3 

4 

5 

On Biomineralization. 
Oxford Univ. Press. New York, 324 p. 

, 
MARTIN, A.J. & FLORES, J.A.. 1 9 9 0 

Ana!isis nanofloristico del Mioceno superior-Piiocene, en el Sondo 116 (DSDP) 
Atlantico nororiental. 

In: Llovera, J.C. & Flores Villarejo, J.A. (eds.). Aetas de Paleontologica. 
pp. 235-245, 3 figs., 2 pis. 
(In Spanish with English summary). 

MARTINI, E. 1 9 9 0 
Tertiary and Quaternary calcareous nannoplankton biostratigraphy off Peru 
(ODP Leg 112). 

In: Suess, E., von Huene, R. et al., Proc. ODP Sci. Results, 112: 
217-238, 1 fig., 12 tbls., 2 pis. 

MICHAELS, A.F. & FLEGAL, A.R. 1 9 9 0 
Lead in marine planktonic organisms and pelagic food webs .. 

Limnol. Oceanog., 35(2): 287-295, 2 figs., 1 tbl. 

MILLER, K.G., KENT, D. V., BROWER, A.N., BYBELL, L.M., 1 9 9 0 
FEIGENSON, M.D., OLSSON, R.K. & POORE, R.Z. 

Eocene-Oiigocene sea-level changes on the New Jersey coastal plain 
linked to the deep-sea record. 

Geol. Soc. A mer. Bull., 1 02(3):331-339, 3 figs., 1 tbl. 

6 MOLFINO, B. & MciNTYRE, A. 1990 
Precessional forcing of nutricline dynamics in the equatorial Atlantic. 

Nature, 249: 766-769, 3 figs., 2 tbls. 

7 MORTIMORE, R.N. 
Chalk or chalk? 

Proc. lnternat. Chalk Symposium. Thomas Telford, 
London, pp. 15-45, 8 figs. 

8 MORTIMORE, R.N. & FIELDING, P.M. 
The relationship between texture, density and strength of chalk. 

.. 

Proc. lnternat. Chalk Symposium. Thomas Telford, 
London, pp. 47-68, 5 figs., 4 tbls., 6 pis . 

9 MULLER, C. 
Nannoplankton biostratigraphy and paleoenvironmental interpretation 
the Tyrrhenian Sea, ODP Leg 107 (western Mediterranean). 

In: Kastens, K.A., Mascle, J. et al.; Proc. ODP Sci. Results, 107: 
495-511, 3 figs., 5 tbls. 

1990 

1990 

1 9 9 0 
from 

Overview 

Strat.; (Syst.) 
TERT.U. 
Atlantic N. 

Strat.; (Syst.) 
TERT.; QUAT. 
Pacific C. 

Living; Bioi. 

Strat. 
TERT.L. 
America N. 

Living; Ecol. 
QUAT. 
Atlantic C. 

Overview 
JURA. to 
QUAT. 
Worldwide 

Diag. 
CRET. 
Europe W. 

. Strat.; Ecol. 
TERT.U.;QUAT. 
Mediterr. 

1 0 PALENIK, B. & MOREL, F.M.M. 1 9 9 0 Living; Ecol. 
Amino acid utilization by marine phytoplankton: a novel mechanism. QUAT. 

Limnol. Oceanog., 35(2): 260-269, 10 figs., 1 tbl. 

1 1 PENA, M.A., LEWIS, M.R. & HARRISON, W.G. 1 9 9 0 Living; Ecol. 
Primary productivity and size structure of phytoplankton biomass on a QUAT. 

transect of the equator at 135° W in the Pacific Ocean. Pacific C. 
Deep-Sea Res., 37(2): 295-315, 7 figs., 7 tbls. 
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RIO, D., SPROVIERI, R., & CHANNELL, J. 1 9 9 0 
Pliocene-early Pleistocene chronostratigraphy and the Tyrrhenian deep-sea record 
from Site 653. 

In: Kastens, K.A., Ma:scle, J. et al., Proc. ODP Sci. Results, 107: 705· 
714, 4 figs., 4 tbls. 

Strat. 
TERT.U.; 
QUAT 
Mediterr. 

RIO, D., SPROVIERI, R., THUNELL, R., GRAZZINI, C.V. & 
GLAFON, G. 

1 9 9 0 lsot.; Ecol. 

Pliocene-Pieistocene paleoenvironmental history of the western 
Mediterranean: a synthesis of ODP Site 653 results. 

In: Kastens, K.A., Mascle, J., et al., Proc. ODP Sci. Results, 107: 
695-704, 6 figs., 1 tbl. 

TERT.U;QUA 
Mediterr. 

3 ROBASZYNSKI, F., CARON, M., DUPUIS, C., ET AL. 1 9 9 0 Strat; (Sysl 

4 

5 

6 

7 

8 

9 

76 

A tentative integrated stratigraphy in the Turonian of central Tunisia: formations, CRET. 
zones and sequential stratigraphy in the Kalaat Senan area. Africa N. 

Bull. Cent. Rech. Explor.-Prod. Elf-Aquitaine, 14(1): 213-384, 
35 figs., 44 pis. 
[Nannofossils by S. Gartner] 

"' RODRIGUEZ-PINDADO, M.L., FLORES, J.A., & SIERRO, F.J. 1 9 9 0 
Estudio bioestratigrafico y Paleoecologico sobre la nanoflora calcarea en el 

(Strat.) 
TERT.U. 
Atlantic N. Mioceno superior-Piioceno del Sondeo 397 (DSDP) - Atlantico nororiental. 

In: Llovera, J.C. & Flores Villarejo, J.A. (eds.). Aetas de Paleontologia 
pp. 315-324, 4 figs. 
(In Spanish with English summary). 

SAMTLEBEN, C. & BICKERT, T. 1 9 9 0 Living; Sedir 
Ecol.; (Syst 
QUAT. 
Atlantic N. 

Coccoliths in sediment traps from the Norwegian Sea. 
Marine Micropaleo., 16: 39-64, 11 figs., 5 tbls., 3 pis. 

SHAFIK, S. 1 9 9 0 Strat. 
CRET.U. 
Australasia 

Late Cretaceous nannofossil biostratigraphy and biogeography of the Australian 
western margin. 

Bureau Min. Res. Rept. 295, 164 p., 14 figs., 31 tbls. 

SJESSER, W .G. 
Bibliography and taxa of calcareous nannoplankton - 15. 

INA Newsl., 12(2): 23-34. 

SIESSER, W.G., BRALOWER, T.J., GALBRUN, B., TANG, C. & 
ODP LEG 122 SCIENTIFIC PARTY 

Cenozoic calcareous nannofossil biomagnetochronology on the Exmouth 
Plateau, eastern Indian Ocean. 

Amer. Assn. Petrol. Geol. Bull., 74(5): 763-764. 

SIMKJSS, K. & WILBUR, K.M. 
Biomineralization. Cell Biology and Mineral Deposition. 

Academic Press, San Diego. 337p. 

1 9 9 0 Bibl. 

1 9 9 o Abst. 
(Strat.) 
TEAT.; QUAT. 
Indian 

1 9 8 9 Bioi. 
Overview 
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1 THUNELL, R., WILLIAMS, D., TAPPA, E., RIO, D. & RAFFI, I. 1 9 9 0 

Pliocene-Pieistocene stable isotope record for Ocean Drilling Program Site 
653, Tyrrhenian Basin: implications for the paleoenvironmental history of 
the Mediterranean Sea. 

In: Kastens, K.A., Mascle, J. et al., Proc. ODP Sci. Results, 
107: 387-399, 7 figs., 3 tbls. 

I sot. 
TERT.U.;QUAT 
Mediterr. 

2 VAN HECK, S.E. 1 9 9 0 Syst. 

3 

4 

5 

6 

7 

8 

9 

On the validity of Pseudoemiliania lacunosa Kamptner 1963 ex Gartner 1967. 
INA Newsl., 12(2): 11-12. 

VAN HECK, S.E. 1 9 9 0 
The ICBN: things you need to know- 2 

INA Newsl., 12(2): 8-10. 

VAROL, 0. 1 9 8 9 
Calcareous nannofossil study of the central and western Solomon Islands. 

..... 

In: Vedder, J.G. & Bruns, T.R. (eds.), Geology and offshore resources 
of Pacific island arcs -- Solomon Islands and Bougainville, Papua New 
Guinea Regions: Houston,Texas, Circum-Pacific Council for Energy and 
Mineral Res. Earth Sci. Series, 12: 239-268, 3 figs., 4 pis . 

VINAS, G.F. , 1 9 8 7 
Estudio del nanoplancton calcareo del Oligoceno superior en las formaciones 
Coatzintla y Escolin. 

..., 

Rev. Soc. M ex. Paleontol., 1 (1 ): 418-428, 5 figs. 
(In Spanish with English abstract) 

VINAS, G.F. & ARREOLA, J.F. 1 9 8 7 ... , 
El estudio del nanoplancton calcareo en Mexico. 

Rev. Soc. M ex. Paleontol., 1 (1 ): 429-432. 
(In Spanish with English abstract) 

WEI, W. 1990 
Clarification of Reticulotenestra perplexa (Burns) Wise 1983. 

INA Newsl., 12(2): 14-16, 3 figs., 1 pi. 

WEI, W. & WISE, S.W. Jr. 1 9 9 0 
Biogeographic gradients of middle Eocene - Oligocene calcareous nannoplankton 
in the South Atlantic Ocean. 

Palaeogeog., Palaeoclimatol., Palaeoceol., 79: 29-61, 29 figs., 1 tbl. 

Syst. 

Strat.; Syst. 
CRET.U.; 
TEAT.; QUAT. 
Australasia 

Strat. 
TERT.L. 
America C. 

Overview 
America C. 

Syst. 

Ecol. 
TERT.L. 
Atlantic S. 

WINTER, A. & MARTIN, K. 1 9 9 0 Ecol. 
Late Quaternary history of the Agulhas Current. 

Paleoceanog., 5(4): - 479-486, 5 figs. 
QUAT. 
Indian 

~+++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

OTHER TITLES 

1 0 ERBA, E. 1 9 9 0 Report 
Meeting report: Jurassic calcareous nannofossil workshop. 

INA Newsl., 12(2): 6-7. 
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FOGG, G.E. 
Our perceptions of phytoplankton - an historical sketch. The First 
Founders' Lecture. 

Brit. Phycol. J., 25: 103-115, 4 figs. 

KUNZIG, R. 
Invisible garden. 

Discover, April, 66-7 4, 4 figs. 

1 9 9 0 Overview 

1 9 9 0 Ecol. 
QUAT. 
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Anacanthoica solomonica VAROL 1989; p. 250, pi. 1, fig. 13. Solomon Islands; also A433-4 
U.S. Gulf Coast, Malta and Turkey; middle Miocene to upper Pliocene. 

Calcidiscus tropicus (KAMPTNER 1955) VAROL 1989, p. 250; (ex Coccolithus) A433-4 

Discoasterbergenii KNUTTEL, RUSSELL & FIRTH 1989, p. 260; pi. 1, fig. 15. North A430-9 
Atlantic, DSDP Holes 541 & 542: ODP Hole 6468, upper Miocene. 

Geminilithella lordii (VAROL 1982) VAROL 1989; p. 250; (ex Umbilicosphaera). A433-4 

Geminilithella petalitormis (VAROL 1982) VAROL 1989; p. 250; (ex Umbilicosphaera) A433-4 

Geminilithella subtilis (Muller 1976) VAROL 1989; p. 250; (ex Cyclococcolithus). A433-4 

Helicosphaera girgisii VAROL 1989; p. 251; pi. 3, figs. 11-13. Solomon Islands, lower- A433-4 
upper Miocene, (NN 1/2 - NN 10); also Cyprus and Turkey, lower Miocene (NN 1/2) and 
in the Caribbean area, middle Miocene (NN 5-NN 8). 

Helicosphaera jakubowskii VAROL 1989; p. 251; pi 2, figs. 5; pi. 3, figs. 1-3. Solomon 
Islands, lower Miocene (NN 1/2 - NN 3) also Cyprus and Turkey, lower Miocene (NN 1/2) A433-4 

Helicosphaera magnitica VAROL 1989; p. 251; pi. 3, figs. 4-9. Solomon Islands, lower 
Miocene (NN 1/2 - NN 3); also in Cyprus, lower Miocene (NN 1/2). 

Helicosphaera mullerae VAROL 1989; pp. 251, & 260; pi. 2, fig. 7; pi 3, figs. 16-21. 
Solomon Islands, middle Miocene (NN 6 to NN 7). 

Hughesius VAROL 1989; p. 261. Type species: Hughesius gizoensis- VAROL 1989. 

Hughesius gizoensis VAROL 1989; p. 261; pi. 4, figs. 9-13. Solomon Islands, Papua 
New Guinea, Turkey, China, Southeast Asia and the Caribbean, lower-middle Miocene 
(NN 6 to NN 11). 

Pontosphaera apocresis (KAMPTNER 1967) AU8RY 1990; p. 261; (ex Discolithus). 

Pontosphaera arcuata (KAMPTNER 1956) AU8RY 1990; p. 267; (ex Discolithus). 

Pontosphaera auleta (KAMPTNER 1967) A8URY 1990; p. 205; (ex Discolithus). 

Pontosphaera australis (KAMPTNER 1956) AU8RY 1990; p. 267; (ex Discolithus). 

Pontosphaera bipertorate (KAMPTNER 1956) AU8RY 1990; p. 271; (ex Discolithus). 

Pontosphaera circumvallatus (KAMPTNER 1956) AU8RY 1990; p. 267; 
(ex Discolithus). 

Pontosphaera deflandrei (KAMPTNER 1956) AU8RY 1990; p. 245; (ex Discolithus). 

Pontosphaera torenus (KAMPTNER 1956) AU8RY 1990; p. 261; (ex Discolithus). 

Pontosphaera giresa (KAMPTNER 1967) AU8RY 1990; p. 253; (ex Discolithus). 

Pontosphaera hora (KAMPTNER 1967) AU8RY 1990; p. 187; (ex Discolithus). 

Pontosphaera lapilla (KAMPTNER 1956) AU8RY 1990; p. 263; (ex Discolithus). 

Pontosphaera multitorata_ (KAMPTNER 1956) AU8RY 1990; p. 271; (ex Discolithus). 
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Pontosphaera multipunctata (KAMPTNER 1956) AUBRY 1990; p.271; (ex Discolithus) A427-4 

Pontosphaera nitea (KAMPTNER 1967) AUBRY 1990; p. 253; (ex Discolithus). A427-4 

Pontosphaera pachymorpha (KAMPTNER 1956) AUBRY 1990; p. 245; (ex Discolithus). A427 -4 

Pontosphaera ovata (LEVIN & JOERGER 1967) VAROL 1989; p. 262; (ex Discolithina) A433-4 

Pontosphaera racla (KAMPTNER 1967) AUBRY 1990; p. 253; (ex Discolithus). A427-4 

Pontosphaera radolensis (KAMPTNER 1967) AUBRY 1990; p. 261; (ex Discolithus). A427 -4 

Pontosphaera redogenus (KAMPTNER 1967) AUBRY 1990; p. 261; (ex Discolithus). A427 -4 

Pontosphaera rorsa (KAMPTNER 1967) AUBRY 1990; p. 249; (ex Discolithus). A427 -4 

Pontosphaera sparsitorata (KAMPTNER 1948) AUBRY 1990; p. 261; (ex Discolithus). A427-4 

Pontosphaera sparsitoratus (KAMPTNER 1948) VAROL 1989; p. 262; ( ex-Oisco/ithus). A433-4 

Pontosphaera sulcata (KAMPTNER 1956) AUBRY 1990; p. 263; (ex Discolithus) A427 -4 

Pontosphaera tanesa (KAMPTNER 1967) AUBRY 1990; p. 187; (ex Discolithus). A427-4 

Pontosphaera trena (KAMPTNER 1967) AUBRY 1990; p. 253; (ex_Discolithus). A427-4 

Pontosphaera trenus (KAMPTNER 1967) VAROL 1989; p. 262; (ex Discolithus). A433-4 

Pontosphaera verbeekii (KAMPTNER 1956) AUBRY 1990; p. 271; (ex Discolithus). A427 -4 

Pontosphaera vigintitoratus (KAMPTNER 1948) VAROL 1989; p. 262; (ex Discolithus). A433-4 

Reticulotenestra producta (KAMPTNER 1963) VAROL 1989; p. 261; A433-4 
(ex Ellipsoplacolithus productus). 

Reticulotenestra stavensis (LEVIN & JOERGER, 1967) VAROL 1989; p. 261; A433-4 
(ex Coccolithus). 

Reticulotenestra tenuistriatus (KAMPTNER 1963) VAROL 1989; p. 261; A433-4 
(ex Coccolithus). 

Rhabdosphaera clavigera var. stylifera (LOHMANN 1902) KLEIJNE & JORDAN 1990; A430-7 
p. 13; (ex Rhabdosphaera stylitera) 

Scyphosphaera praeglobulata VAROL 1989; p. 262; pi. 2, figs. 14-15; pi. 4, figs. 3-4. A433-4 
Solomon Islands, Turkey and Egypt, upper Miocene. 

Scyphosphaera pseudorecurvata VAROL 1989; pp. 261-262; pi. 1, figs. 9-10; pi. 4, figs. A433-4 
7-8. Solomon Islands, upper Miocene. 

Sphenolithus turcatolithoides LOCKER 1967, subsp., labradorensis FIRTH 1989; p. 277, A429-3 
pi. 2, figs. 15 & 16; pi. 3, figs. 1-4. Labrador Sea, ODP Hole 647; South Atlantic, ODP 
Hole 356; middle Eocene. 

Syracolithus ponticuliterus (KAMPTNER 1941) KLEIJNE & JORDAN 1990; p. 13; A430-7 
(ex Corisphaera ponticulifera). 
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Calcareous Nannoplankton Species 

bergenii, Discoaster 
furcatolithoides ssp. labradorensis, Sphenolithus 

girgisii, Helicosphaera 
gizoensis, Hughesius 

jakubowskii ~ Helicosphaera 
magnifica, Helicosphaera 
mullerae, Helicosphaera 

praeg/obulata, Scyphosphaera 
pseudorecurvata, seyphosphaera 

solomonica, Anacanthoica 

Calcareous Nanno.plankton Genera 

Hughesius 
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Rita Catanzariti 

Via I Possenti, 10 
56010 Asciano Pisano (PISA) 
IT ALIA 

J.A. Curto 
Universitat de Barcelona 
Dept. de Geologia Dinamica 
Geofisica i Paleontologia 
Facultat de Geologia 

NEW MEMBERS 

Zona Universitaria de Pedralbes 
08028 Barcelona SPAIN 

M.P. Gring 
Unocal Oil & Gas Division 
Unocal Corporation 
P 0 Box 6176 
Ventura 
CALIFORNIA 
93006 USA 

Mircea Leu 
Oil Geological Research Institute 
103 Toamnei Street 
Bucharest 72152 
ROMANINA 

Musa Musbah 
Sarawak Shell Berhad 
98009 Miri 
MALAYSIA 

V.B. Quidayan 
P.T. Core Laboratores, Indonesia 
Bldg.303 
Cilandak Commerical Estate 
Jln, Cilandak K.K.O. 
Jakarta 12560 
INDONESIA 
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Lie. Andrea Concheyro 
J.B. Ambrosietti 662 
Piso 6, Dto. 28-29 
CP (1405) Buenos Aires 
AGENTINA 

T. Dunn 
214 Bessey Hall 
Geology Dept. 
University of Nebraska 
Lincoln 
Nebraska 68588-0340 
U.S.A. 

Karl-Heinz Kirsch 
Institut Fur Palaeontologie und 
Historische Geologie 
D-8000 Munchen 2 
Richard-Wagnerstr 10 
WEST GERMANY 

Liu Huabibao 
Dept. Geology 
214 Bessey Hall 
Univ. Nebraska 
Lincoln 
Nebraska 68588-0340 
U.S.A. 

J.J. Pospichal 
Dept. of Geology 
Florida State University 
Tallahassee 
Florida 32306 
U.S.A. 

Purtyasti Resiwati 
Dept. Geology 
214 Bessey Hall 
Univ. Nebraska 
Lincoln 
Nebraska 68588-0340 
U.S.A. 
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David Rutledge 
Postgraduate Unit of Micropalaeontology 
Dept. of Geological Sciences 
University College London 
Gower St 
LONDON 
WClE 6BT 

M. Triantaphyllou 

Lyssippou 7 
GR-11635 
Athens 
GREECE 

Andrew Wadsworth 

72 Cammel Road 
Ferndown 
Dorset 
BH22 8SB 
UNITED KINGDOM 

CNRS/INIST 
Bibliotheque 
54514 Vandoeuvre Cedex 
FRANCE 
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Carlos Lancis Saez 
Dept. Ciencias Ambientales 
Div. geologia 
Facultad de Ciencias 
Universidad de Alicante 
Apartado 99 
Alicante, ESPANA 

J. van Bleijswijk 
NIOZ Dept. Pelagische Systemen 
Postbus 59 
Den Burg 
Texel 
THE NETHERLANDS 

Editorial Manager 
Biosis U.K. 
Garforth House 
54 Micklegate 
York 
North Yorkshire 
YOl lLF 
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T.J. Bralower 
Dept of Geology 
Univ. of N. Carolina 
CB 3315 Mitchell Hall 
Chapel Hill 
N.C. 27599-3315 
U.S.A. 

M. Knappertsbush 
Virje Universiteit 

CHANGE OF ADDRESS 

Faculteit der Aardwetenschap pen 
Vak Groep Sedimentaire Geolo gie 
De Boelelaan 1085 
1081 HV Amsterdam 
THE NETHERlANDS 

M. Rossi 
Servizio Geologico Nazionale 
Largo S. Suzanna 13 
00187 Roma 
ITALY 

Verdenius 
Inst. for Kontinential 
Sokkelundersokelser 
7034 Trondheim 
NORWAY 
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Simon Houghton 
Adams Environmental 
Unit 54 
103-109 Lavender Hill 
LONDON 
SWll SQF 
U.K. 

P .L. Miller 
371 Castello Road 
Lafayette 
California 94549 
U.S.A. 

Joost Verbeek 
Geol. Survey of the Netherlands 
Richard Holkade 10 
P 0 Box 157 
2000 AD Haarlem 
THE NETHERlANDS 
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NEWSLETfER -ADVICE TO CONTRIBUTORS 

TYPES OF CONTRIBUTION 
The newsletter is essentially informal and contributions of any type submitted in any form will 
be considered, if not necessarily accepted. The following notes are a guide to possibilities rather 
than a set of directions. 

A BIBLIOGRAPHIES: These are produced by the bibliographers. Any suggestions, reprints 
of articles, and details of omissions should be sent to them directly. 

B. ARTICLES: Short articles on any aspect of nannoplankton work are welcomed. Discussion, 
review, synthesis, and methodology articles are particularly welcome. Any articles with scientific 
content may be reviewed and should be submitted at least two months before the final copy 
deadline. The newsletter is a valid publication for taxonomic articles. 

C. REVIEWS: Reviews of books, equipment items, or computer software and conference 
reports are welcome. To avoid duplication the idea may be suggested to the editor in advance 
of submission. 

D. NEWS, & NOTES: Any news items, on forthcoming conferences, research projects, new 
appointments are welcome. 

SUBMISSION PROCEDURE 
Two copies should be sent of all submissions. Include Fax number if available, for proof 
checking. News items and initial drafts of articles can be sent in draft form. Other items should 
be sent either as proof ready copy or on computer disc. 

PROOF READY COPY: Submit on A4 paper (210x297mm) with 2.5cm left, right and top 
margins, 3.5cm bottom margin. Single spacing, 15point (elite) text. If possible use a laser printer. 

SUBMISSION ON DISC: Include print-out and details of system used. I can easily handle the 
following. IBM/MS-DOS, any format, 5.25" or 3.5", discs (ideal 5.25", 1.2 Mb). Text as 
WordPerfect, WordStar, Smart, DCA, Navy DIF, MultiMate, or ASCII files (ideal WordPerfect 
5.0). Macintosh, 3.5" discs, Ms-Word, MacWrite or ASCII files. Amstrad, 3"discs, Locoscript, 
Wordstar, Tasword or ASCII files. Any alterations to the text, other than for spelling or very 
minor mistakes, will be checked with the author. 

DIAGRAMS: Should be submitted as very clean computer printouts, photographs or 
photocopies of final size, do not send large or delicate originals. 

REFERENCES: Use standard (World List) abbreviations, and format of examples below. ODP 
& DSDP volumes should be treated as periodicals using the following abbreviations: IRDSDP; 
Proc. ODP Init. Rep.; Proc ODP Sci. Res. 

SpencerS. & Dobb A 1988: New observations on Upper Cretaceous vombatidae. J. Wom. Res., 
25, 35-67. 

McCarthy J.J. 1980: Nitrogen. In, Morris I. (ed.) "The Physiological Ecology of Phytoplankton", 
Blackwell, p.191-234. 

INA NEWSLETfER: Published by the International Nannoplankton Association. Printed by Archer Press, London. 
ISSN .0255.013X 
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